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Introduction 
The Practice CS Project Management module is a separately licensed add-on 
module that enables you to manage and track your firm’s projects and tasks in 
Practice CS. After you have completed the walkthrough, you will have an 
understanding of the project management workflow in Practice CS. You will also 
learn how to do the following: 

 Create project and task templates to use in setting up projects 

 Assign solutions to projects 

 Enable notifications to inform your staff when project information changes 

 Use dashboards to manage project and task information 

 Update project and task information during time entry 

 Analyze projects and tasks using Practice CS reports and calendars 

Note: This walkthrough assumes you are familiar with using Practice CS or that you 
have read chapter 3, Program Overview, in the Practice CS Getting Started guide.  

Opening the sample database 
To perform the exercises in this walkthrough, you will start Practice CS and log in to 
the Sample database as staff CAT. To log in, follow these steps.  

1. Start Practice CS.  

2. In the login dialog, select Sample in the Open Firm field. 

3. In the Staff ID field, select CAT. 

Note: If you previously marked the Remember login information checkbox, hold 
down the SHIFT key when you double-click the Practice CS icon and continue 
to hold down the SHIFT key until the login dialog appears.   

 

http://cs.thomsonreuters.com/ua/_pdfs/practice/cs_us_en/external/practice_getting_started.pdf
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4. Click OK.   

 

Backing up the sample database 
Data that you enter while performing the exercises in this walkthrough will affect the 
Sample database. Therefore, we recommend that you make a backup of the 
Sample database before you begin so that it is available for use in other 
Practice CS walkthroughs.  

Note: If you are running Practice CS through the Virtual Office CS™ module, the 
Backup menu command is not available. We recommend that you install a local 
copy of Practice CS so that you can back up the Sample database. For instructions 
on installing the program, please see chapter 2, Installation Instructions, in the 
Practice CS Getting Started guide.  

To back up the Sample database, follow these steps.  

1. In Practice CS, choose File > Backup. 

2. In the Backup file field, enter the path and file name for the backup file, or click 

the  button and navigate to the backup file location. The backup file will have 
a file extension of BDF.   

Note: The backup file will be created on the computer where the data resides. 
The path specified here must be a valid path on that computer.  

PRACTICE CS
partoftheCSPROFESSIONALSUITE?

Open Firm: Sample

Staff ID: CAT

THOMSONREUTERS
Version 2014.X.X

OK Cancel

 

 

 

  

  

 
 

 

http://cs.thomsonreuters.com/ua/_pdfs/practice/cs_us_en/external/practice_getting_started.pdf
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3. Click OK.    

 
4. When prompted that the backup is complete, click OK.  

Note: After you complete this walkthrough, you can restore the sample database. 
For instructions, see “Restoring the sample database” on page 67. 

  

Backup Firm X

Please enter the path and file name for your Firm database backup file.

Backup file: 50.CREATIVESOLUTIONVMSSQLAData\CSP_999_Sample4_20140409162058.bdf

Schedule a recurring backup

OK Cancel
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Setting Up Projects 
This chapter describes some key elements of the Practice CS Project Management 
module — project templates, tasks, and tracking descriptions — and their role in 
creating projects for your clients. 

Overview 
Before you begin using the Project Management module, you will need to set up 
templates for your firm’s projects and tasks. You will also need to set up tracking 
descriptions that you will use to indicate the status of projects and tasks. If your firm 
wishes to track additional information for projects or tasks using custom fields, you 
will need to create those fields.  

Project templates 
Project templates define projects that your firm routinely performs, such as tax 
returns, payroll, and year-end audits. They contain key project information, such as 
date calculations, recurrence patterns, project tasks, budget information, 
assignments, and future project generation.  
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Project templates, which provide default information when you set up a project for a 
client, are global items, while projects are client-specific items. When you create a 
project for a client, you select a project template, and project information is filled in 
from that template.   

 

Tasks 
Tasks are the individual activities that are performed while working on a project. 
Tasks are not required in Practice CS, but they can assist your firm in managing 
staff and budgeting. Each task is identified by an Activity.  

Note: Care should be taken when defining Activities, as they are a part of the core 
structure of Practice CS. For further details on setting up Activities, please read the 
“Activity setup” section of the Practice CS Getting Started guide. 

Tracking descriptions 
Tracking descriptions describe the current status of each project and task in your 
firm. Practice CS includes four standard tracking descriptions — Not Started, 
Started, Canceled, and Completed — but you can add as many other tracking 
descriptions as your firm needs. You can assign tracking descriptions to project 
templates, task templates, client projects, and project tasks.  

To add tracking descriptions, choose Setup > Tracking Descriptions. 

 Practice CS - [Sample4] - [Project Templates] x
File Edit View Actions Setup Iools Help

GBack--2##ÿ# ÷ pP| Search for assistance
Project Templates
Search:709 MainTasks Links Custom Fields

ID Description Identification
706 Estate Tax Return ID: 709
709 Gift Tax Return Description: Gift Tax Return941 941 Employer's Quarter F
990 Not For Profit Tax Return Preparation of U.S. GitTax Retum forthe year ended [Date Fomat(Report Date Perniod End(-1)."MMMM d. yy")].

Invoice description:
1040 Individual Income Tax Ret
1040ES 1040 Estimated Tax Paym Project information Groupings
1040EXT 1040 Extension  Engagement:Business Tax Services ÿ Responsible:Client Partner 1040NOTICE Individual Tax Notice

Pane1040SIMPLEIndividual Income Tax Ret Priority: Normal ÿ Department: Tax Department
1040TAXPLANIndividual Tax PlanningTracking:  Not Started ÿ

 Navigation 1040X Amended Individual IncomEntities 
1041 Estate and Trust Tax Retu
1065 Partnership Tax ReturnAssociated Entities:

1099 1099 Budget information Assigned
1120 Corporate Tax Return  Base on Tasks S  Engagement Manager
1120S S Corporate Tax Return Calculate amount automatically
1120w 1120 Estimated Tax Paym
ACCTSYSCONFAccounting System ConfigHours: 0.00
ANNSALESUSEAnnual Sales & Use TaxAmount: $0.00]
ANNUALCOMPAnnual Compilation Generation Solution-
APRWRITEUPApril Writeup  Select solution:OtherAUDIT
AUDIT2 Audit2 Pattern: Due on every April 15  Solution path:
AUGWRITEUPAugust Writeup
BIWEEKPAYRLBi-Weekly Payroll 
BUSAMENDTRBusiness Amended Tax RExtensions

Business Tax Extension Extend the original due date by:BUSTAXEXT
BUSTAXNOTICBusiness Tax Notice Extension Number Month(s) Day(s)
BUSTAXPLANBusiness Tax Planning 6

CONSULTING Consulting
DECWRITEUPDecember Writeuo

PP Edit Delete  Import Default Project Templates Ja3 Cancel 

For Help. press F1 Current Login: CAT  Current Period: 4/1/2014 - 4/30/2014

  
 

   
 

    

   
    

  
    

   
  

    
  

      
 

      
    

 
  
   

    
     
     

    

    
  

     
    

  
 
   

   
     

  
 

 
  

    

http://cs.thomsonreuters.com/ua/_pdfs/practice/cs_us_en/external/practice_getting_started.pdf
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Custom fields 
You can track additional information for projects and tasks using custom fields. To 
set up custom fields, choose Setup > Custom Fields, and then choose either 
Projects or Tasks. There are six custom field types available in Practice CS: 
checkboxes, dates, lists, numbers, staff lists, and text fields. 

Custom fields for projects and tasks appear on the Custom Fields tab of the Project 
and Task dialogs, and also on project and task templates. 

Project setup 
In this section, you will set up the following: 

 Project template 

 Task template 

 Firm notifications 

 User preferences for project management 

Setting up a template for a 1040 tax return project 
Follow these steps to create a sample project template for a U.S. Individual Income 
Tax Return (1040EX). 

1. From the Setup menu, choose Templates > Projects. 

2. Click the Add button. 

: Use these fields to choose a name that will help you identify the project 
template when you want to assign it to a client. For this exercise, enter 1040EX 
in the ID field.   

4. In the Description field, enter 1040 Tax Return Example.   

5. Click Enter to save the sample template. 

6. To help with setup, Practice CS allows you to copy entire tabs from one project 
template to another. The information on the Main tab of the 1040 project 
template is identical to what we want for the 1040EX project template.  

Note: You can copy entire project templates to create a new template, or copy 
individual tabs from one template to another. When copying a template, you will 
need to use a new ID. When copying tabs, all information on the destination tab 
will be overwritten. 

3. ID
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 7. Right-click the 1040 template in the list of project templates and choose Copy 
Main Values To from the context menu.   

 
8. In the Copy Main Values To dialog, choose the 1040EX template from the To 

field.   

 
9. Mark the I understand this will replace any existing data checkbox and click the 

Copy Now button.   

 
10. The 1040EX project template is now set up with most of the values already 

filled in.  

Copy Main Values To X

From: 1040-Individual Income Tax Return

To:
ID Description

706 Estate TaxReturn

709 Gift Tax Return
941 941 Employer's Quarter Fed TR
990 NotForProfitTaxReturn

1040 Individual Income Tax Return
1040ES 1040 Estimated Tax Payments
1040EX 1040TaxReturnExample
1040EXT 1040 Extension

Copy Main Values To X

From: 1040 - Individual Income Tax Return

To: 1040 TaxRetunExample

Iunderstand this will replace any existing data

Copy Now
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11. In the ID field, change the ID to 1040EX. 

12. Change the Description field to 1040 Tax Return Example.  

13. In the Invoice description field, enter US Individual Income Tax Return. This is 
the description that can appear on client invoices if your invoice format is set up 
to pull the project invoice description.    

 
14. Project information: Use this section to assign an engagement, a priority, and a 

default tracking status to the project template. Verify that the following 
information is selected: 

 Engagement: Individual Tax Services  

 Priority: Normal 

 Tracking: Not Started   

 
15. Groupings: Use these fields to make assignments for the project. You can 

select a specific staff or department, or a dynamic link to be determined when 
the project is added to a client. In the Department field, click the down arrow  
button and select Responsible Staff Department.    

 Practice CS - [Sample5] - [Project Templates*] x

File Edit View  Actions Setup  Iools  Help
Back--eKÿ- ÿ - PP | Search for assistance

 Project Templates
Search: Main TasksLinks  Custom Fields

ID Description Identification -
706 Estate Tax ReturnID: 1040EX
709 Gift Tax Return 

Description: 1040 Tax Retum Examplel 
941 941 Employer's Quarter
990 Not For Profit Tax Retur US Individual Income Tax Retum 

Invoice description:
1040 Individual Income Tax R
1040ES 1040 Estimated Tax Pay Project information Groupings
1040EX 1040 Tax Return ExampEngagement:Individual Tax Services Responsible: Client Partner

Pane
1040EXT 1040 Extension
1040NOTICEIndividual Tax NoticePriority:  Normal Department:Tax Department 

Individual Income Tax RTracking:  Not Started .
Individual Tax Planning Entities

1040X  Amended Individual Inco
Associated Entities:Individual Entity1041 Estate and Trust Tax Re

1065  Partnership Tax ReturnBudget information Assigned
1099 1099  Base on Tasks Staff  Engagement Manager
1120  Corporate Tax Return Calculate amount automatically 
1120S S Corporate Tax Return
1120w 1120 Estimated Tax PayHours: 0.00
ACCTSYSCOAccounting System ConfAmount: $0.00]
ANNSALESUAnnual Sales & Use TaxGeneration- Solution-
ANNUALCOAnnual Compilation

Select solution:OtherAPRWRITEUApril Writeup
AUDIT ipny Pattern:Due on every April 15  Solution path:
AUDIT2 Audit2
AUGWRITEUAugust Writeup
BIWEEKPAYBi-Weekly PayrollExtensions

 Extend the original due date by:BUSAMENDTBusiness Amended Tax
BUSTAXEXT Extension Number Month(s) Day(s)Business Tax Extension

Business Tax Notice 1 6
BUSTAXNOT

0

BUSTAXPLA Business Tax Planning
 PPA nip3 Delete Import Default Project Templates J

For Help. press F1 Current Login: CAT Current Period: 4/1/2014 - 4/30/2014 

Projectinformation

Engagement: Individual TaxServices

Priority:

Tracking Not Started
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16. Entities: Use the Associated Entities field to assign an entity to the project 

template. Select Individual Entity. 

Notes  

 To select entities, click the More button and select them in the 
Associated Entities dialog.   

 Adding entities to a template can speed up project setup for new clients. 
When you are setting up a new client, if you select an entity that is 
associated with a project template, the program will prompt you to add 
projects to the client that are related to that entity. 

17. Budget information: Verify that the Base on Tasks checkbox is marked. This 
bases the project’s budget information on the information set up on the project's 
tasks.   

 

Notes  

 If your firm does not use tasks, you can clear the Base on Tasks checkbox 
and enter the project’s budgeted hours and amount here, or mark the 
Calculate amount automatically checkbox to have Practice CS calculate 
budget information based on staff rates. The budget will calculate 
automatically using the assigned staff member’s hourly rate for the billing 
rate assigned to the project’s engagement. Additionally, you can choose not 
to include any budget information on the template. You can add budgets to 
the project once it is added to the client. 

 We have not yet set up task template information for this project template, 
so the Hours and Amount fields are still 0.00. 

18. Assigned: In the Staff field, click the  button and select Client Manager from 
the drop-down list.   

Note: If your firm is licensed for the Staff Management module, you can assign 
projects and their tasks to a work queue based on staff qualifications. Qualified 
staff can then select available projects and tasks from the work queue. For 
more information on using the work queue, please see the topic Using the work 
queue in the Practice CS Help & How-To Center and the Practice CS Staff 
Management WalkThrough for a step-by-step exercise.  

Groupings

Responsible ClientPartner

Department: Responsible Staf Department

Budgetinformation

BaseonTasks

Calculate amount automatically

Hours: 0.00

Amount: $0.00

ÿ

   

 

  

 

 

 

 

  

 

http://cs.thomsonreuters.com/ua/practice/cs_us_en/staff_mgmt/using_work_queues.htm?product=practice&mybanner=1
http://cs.thomsonreuters.com/ua/practice/cs_us_en/staff_mgmt/using_work_queues.htm?product=practice&mybanner=1
http://cs.thomsonreuters.com/ua/_pdfs/practice/cs_us_en/external/practice_cs_staff_mgmt_wt.pdf
http://cs.thomsonreuters.com/ua/_pdfs/practice/cs_us_en/external/practice_cs_staff_mgmt_wt.pdf
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19. Solution: You can use this section to assign the project template to an 
application, document, or spreadsheet (such as UltraTax CS,® Creative 
Solutions Accounting,™ Accounting CS,™ Financial Analysis CS,® Fixed Assets 
CS,® Microsoft® Word® or Excel,® or other application you have installed) that 
you will use to work on the project. When you or your staff begin work on the 
project, you will be able to launch the solution directly from the project or task. 

Note: If your firm uses tasks in Practice CS to track specific work on non-tax 
projects, you will want to add solutions on the task templates rather than the 
project template. 

 Select solution: Because this is a tax-related project, select UltraTax CS 
from the drop-down list (if licensed). 

 Completion event: Leave this blank on the project template.  

Note: If you are licensed for UltraTax CS, you can log the status event in 
UltraTax CS that matches the completion event in Practice CS. This will 
mark the project as completed in Practice CS. For this reason, we 
recommend that if you are using tasks, you add your completion events on 
the task templates and use the extension events on the tax-related project 
templates. 

20. In the Extension Event field, enter Return Extension Filed. 

Note: You would also need to add this entry to your status events in 
UltraTax CS. 

The Extensions section defines any due date extensions that might be 
necessary for this type of project. The Extension Number indicates the 
sequence for any extensions that you enter, and Months(s) indicates the 
number of months and/or days by which the project should be extended past 
the original due date, if necessary. For this exercise, leave the extensions 
section as it is. 

21. In the Generation section, click the Recurrence  button to open the 
Recurrence dialog. Use this dialog to set up the project recurrence pattern and 
to select which information to carry over from the previous project when you 
generate new projects.   

22. Frequency: Verify that the following information is selected: 

 Pattern: Annually.  

 Must occur on weekdays  

23. If necessary, unmark the Base on Client fiscal year ends checkbox, and set the 
due date as Due on every April 15.  

24. Target dates: This section specifies the dates you anticipate starting and 
completing the project. The Start date specifies the project’s target start date, 
using the number of months and days before due date or after received date. 
The Complete date specifies the target complete date, using the number of 
months and/or days before due date or after received date. 
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Set up the project template’s target start date to start 3 month and 15 days 
before due date, and the project template’s target complete date to 15 days 
before due date.   

 
25. Expiration: Click the No end date option.   

 
26. Generation: Click the When the current Schedule Item is complete option to 

generate the next project as soon as the current project is completed. 

Notes  

 If you click __ month(s) __ day(s) before next occurrence, the next 
occurrence of the project will be generated on the designated date, whether 
or not the current project is complete.  

 lick When I manually create it to manually create the next project. 

 If you click Generate all, the program will generate all of the projects now. 
This option is not available when No end date is selected for the expiration 
date. 

27. Project Generation Options: You can choose to have the next project generated 
based on either the project template or on the current project’s settings. If you 
want to use certain settings from the current project, mark the appropriate 
checkboxes. For this exercise, unmark all of the checkboxes.  

Target dates

Start: month(s) 15 day(s) Before due date

Complete: month(s) 15 day(s) Before due date

Expiration

Endafter

 C 

 

     

    

 



Setting up projects 

Practice CS Project Management WalkThrough 13 

28. Click OK.    

 

29. Click Enter to save the template. 

Opening the Task Template dialog  
You can define the specific tasks that must be performed to complete a project. 
Tasks are not required, but they can help with achieving electronic workflow and 
budgeting in more detail. 

1. With the 1040EX project template selected, click the Edit button to edit your 
project template, and then click the Tasks tab. 

Recurrence*
Frequency
Pattern:Annually Must occur on weekdays  Base on Client fiscal year ends

O Due on everyApril 15

 Due on thelast weekday of December

Target dates
3ÿ month(s)15ÿ day(s) Before due date 

Complete:0 month(s)15 day(s)Before due date
 Expiration 
ONo end date
 End after occurrences

Generation
Generate the next Schedule ltem:

O When the current Schedule Item is complete
3ÿ month(s)15 day(s) before next occurrence

O When I manually create it 
O Generate all

Project Generation Options
Generate using the current Project:
Descriptions Notes Budget information] Actual
 Engagement  Links Budget adjustment factors:
Grouping selectionsCustom Fields valuesHours:1.0000

 Assigned selections Task information Amount:1.0000

Calendar Entries
OK Cancel
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2. On the Tasks, tab, click the Add button.   

 
 Order — Determines the order in which tasks should be completed. By 

default, the task order numbers start at 1 and increment by one. Order 
values must be numeric but do not need to be unique; you can use the 
same order number to create multiple tasks that should be completed 
concurrently.  

 Activity — Assign an activity to the task template. Activities are not required, 
but they help to identify the actual task to be performed. 

 Staff — In the Staff field, you can assign a specific staff member to the task 
template, or a dynamic link to be determined when the project is added to a 
client. You can also leave this blank, and assign the staff later when the 
project is assigned to a client. 

Task Template
Task Links Custom Fields

Identification Target dates
Order: 3 month(s)15 day(s)Before due date

Activity: Complete:ÿ month(s)15 day(s)Before due date

Description:
Task Information Assigned

Tracking description:e Staff:

Budget information Solution

Calculate amount automatically Select solution:UltraTax CS
Hours: 0.00 Completion event:

Amount: $0.00ÿ

Notes

QK Cancel
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Notes 

 The Target dates and Solution sections of the Tasks tab serve the same 
purpose as for projects but are specific to each task. The Notes field is 
optional. 

 If you are using UltraTax CS and populate completion events on your tasks 
that match status events in UltraTax CS, when a status event is logged in 
UltraTax CS, the task's tracking description will be updated to Completed in 
Practice CS. 

 If your firm is licensed for the Staff Management module, you can assign 
projects and their tasks to a work queue based on staff qualifications. 
Qualified staff can then select available projects and tasks from the work 
queue. For more information on using the work queue, please see the topic 
Using the work queue in the Practice CS Help & How-To Center and the 
Practice CS Staff Management WalkThrough for a step-by-step exercise.  

 You can choose to have Practice CS calculate the budget amount 
automatically based on the assigned staff member’s hourly rate for the 
billing rate assigned to the project’s engagement or task’s activity.  

Adding tasks to a project 
1. Add the following task templates to the 1040EX project template. 

Field Entry 
 Task 1 Task 2 Task 3 Task 4 
Order 1 2 3 4 

Activity Client 
Meetings & 
Discussions 

Preparation 
 

Review Assembly 

Tracking 
Description 

Not started Not started Not started Not started 

Start 3 month(s) 15 
day(s) Before 
due date 

3 month(s) 15 
day(s) Before 
due date 

0 month(s) 15 
day(s) Before 
due date 

0 month(s) 15 
day(s) Before 
due date 

Complete 0 month(s) 15 
day(s) Before 
due date 

0 month(s) 15 
day(s) Before 
due date 

0 month(s) 15 
day(s) Before 
due date 

0 month(s) 15 
day(s) Before 
due date 

Staff CAT None CAT None 

Select Solution UltraTax CS 

Completion 
Event 

Client Meeting 
Complete 

Preparation 
Complete 

Review 
Complete 

Client Copy 
Complete 

 

Notes 

 You can add links to tasks by clicking the Links tab. See “Adding links” on 
page 19 for more information. 

 If your firm has defined custom fields for tasks, click the Custom Fields tab 
and enter the appropriate information. 

http://cs.thomsonreuters.com/ua/practice/cs_us_en/staff_mgmt/using_work_queues.htm?product=practice&mybanner=1
http://cs.thomsonreuters.com/ua/_pdfs/practice/cs_us_en/external/practice_cs_staff_mgmt_wt.pdf
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lick Enter to save the task template.   

 

Other project setup options 
Now that we have created a project template for the 1040EX - 1040 Tax Return 
Exercise, let's look at setup options for some other types of project templates. 

Generation options 
When generating future projects, you have the following options for when to 
generate the next project: 

 When the current Schedule Item is complete 

  month(s) / _ day(s) before next occurrence 

 When I manually create it 

 Generate all 

   

Generation

Generate the next Schedule ltem:

When the current Schedule Itemis complete

month(s) 15 day(s)before next occurrence

When I manually create it

Generate all

Project Generation Options
Generate using the current Project:

Descriptions Notes Budget informationActual

Engagement Links Budget adjustment factors:
Grouping selections Custom Fields values Hours: 1.0000

Assigned selections Task information Amount:1.0000

Calendar Entries

2. C

 _
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When generating a recurring project such as a monthly write-up, using the second 
option — entering the number of months and days before the next occurrence of the 
project — can help simplify project planning by allowing you to postpone generating 
future projects until closer to their due date. Generating projects this way allows you 
to see only current projects and any projects that are overdue. 

For example, if your write-up projects are typically due at the end of the month, you 
could set up the template to generate the next project 10 days before the current 
project is due. At the end of the month, you can filter your list of projects to show 
only the projects for the next month and any outstanding projects that have not yet 
been completed.   

 

Note: See page 34 for details on using the Manage Projects screen. 

Manage Projects
ProjectsProject Tasks

Search

Project Tel S MARWRITEUP Open Projects only

Due 
# Client ID Client Description  Parent ClientProject Project DescriptionEngagementResponsibleAssigned Office ExtensionIs Extended

 Due : 4/30/2014 (2 items)
560ACEADVERTAce AdvertisingACEADVERTMARWRITEUPMarch WriteupACCOUNTINGRogers, MelissaTurner, CindyCALIFORNIA
576 CRAWFORDCrawford's SteakCRAWFORDMARWRITEUPMarch WriteupACCOUNTINGTurner, CindyTurner, CindyMICHIGAN

TasksHistory
Order DescriptionActivity Assigned In Work QueueStaff QualificationsTarget Start Target CompleteTrackingStarted Completed
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Recurrence patterns 
For a recurring project, such as payroll, due date options change depending on the 
recurrence pattern you select for the project template. If you choose Monthly, you 
need to specify the due date of the month (for example, the 31st of every month) or 
which weekday of every month. You can also have the program adjust the due date 
so that it must fall on a weekday.   

 

If your payroll is due semi-monthly, you must choose either 1st and 15th or 15th and 
last day of month as your due date.   

 

However, if your payroll is due bi-weekly instead of semi-monthly, you can choose 
Daily for the recurrence and specify that the project is due every 14 days on a 
weekday.   

 

Recurrence*

Frequency
Pattern: Daily Mustoccuron weekdays

Due every 14 day(s)
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Notes  

 If you select None for the recurrence, no due date options are available, and 
you must manually generate the next project when the current project is 
complete.  

 If you select Periodic for the recurrence, you must select at least one month 
from the drop-down list and enter a day of the month in the field provided.  

Adding links 
You can link projects and tasks to files, folders, and web pages. You can also add 
links to FileCabinet CS® documents or GoFileRoom® documents, if you are licensed 
for these applications. This feature enables you to associate items with project or 
task templates, which adds the links for each new project or task generated from 
the template, or with individual projects or tasks. For example, you could link a task 
template to a checklist used for completing that task. 

1. Open the project template, task template, individual project, or individual task to 
which you want to add the link. 

2. Click the Links tab. 

3. Right-click within the tab and choose the command for the type of link you want 
to add. 

 Add Files 

 Add Folder 

 Add Web Page 

 Add FileCabinet CS Document 

 Add GoFileRoom Documents 

4. Navigate to and select the item to which you want to link, then click OK. (For 
files, click Open.) 

Custom fields 
If your firm has defined custom fields for projects, click the Custom Fields tab and 
enter the appropriate information. 
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Duplicate task orders 
When you add tasks to a project, each task is assigned an order, starting with 1 by 
default. You can change the order numbers, if necessary. For example, some 
projects may have tasks (such as audit fieldwork procedures) that need to be 
performed simultaneously by multiple staff. To indicate simultaneous tasks, you can 
use duplicate order numbers. This way, you can signal that the next task is ready to 
be worked on as soon as all of the simultaneous procedures are completed. All 
tasks with the same order number will be ready to be worked on at the same time, 
and tasks with the next order number will not be ready to be worked on until all 
tasks with the previous number have been completed.   

 

Notifications 
Notifications are global setup items, enabled at the firm level, that inform staff 
members when monitored events occur. You can set up notifications to be delivered 
to specific staff and also by staff role (for example, to the staff designated as 
Responsible or Assigned on a project). All notifications can be viewed in the 
Notifications portlet on the Staff dashboard. They can also be received as desktop 
notifications, which appear temporarily on screen and then fade away, similar to 
email notifications in Microsoft® Outlook.® Staff members can specify in their User 
Preferences whether they want to receive desktop notifications.  

 Practice CS - [Sample4] - [Project Templates] ÿ
Eile Edit View  Actions Setup  Iools Help

O Back - e#ÿ eID Add -  Search for assistance

Project Templates

Search:  Main TasksLinks Custom Fields
ID  Description Order / DescriptionAssigned ActivityTrgt Comp M  Trgt Comp DTracking

706 Estate Tax Return 1Assign & Bu Engagement  Assign & Bu5 23Not Started 
709 Gift Tax Return 5Engagement Engagement5 21 Not Started 
941 941 Employer's Quarter Fe  5 Pre-Analytic Pre-Analytic 2  21  Not Started 
990 Not For Profit Tax Return  5Risk Assess Risk Assess 2  21  Not Started 
1040  Individual Income Tax Ret 5 Minutes  Minutes 2 21Not Started
1040ES 1040 Estimated Tax Paym 10 Cash Cash  20 Not Started 
1040EX 1040 Tax Return Example10Accounts Re Accounts Re  20  Not Started 

Pane1040EXT 1040 Extension 10Inventory Inventory  20 Not Started
1040NOTICEIndividual Tax Notice10Prepaids & Prepaids & 20 Not Started 
1040SIMPLEIndividual Income Tax Ret 10 Property. EqProperty. Eq  20  Not Started 
1040TAXPLANIndividual Tax Planing10Notes Payab Notes Payab 1 20 Not Started
1040X  Amended Individual Incom 10Accounts Pa Accounts Pa 1  20  Not Started 
1041 Estate and Trust Tax Retur10 Other Curre Other Curre 1  20 Not Started 
1065 Partnership Tax Return 10Equity Equity  20 Not Started 
1099 1099 10Income Tax Income Tax 20 Not Started
1120 Corporate Tax Return 10Revenues Revenues  20 Not Started 
1120S S Corporate Tax Return10 General. Ad General. Ad 1  20 Not Started 
1120w 1120 Estimated Tax Paym10 Other lIncom  Other Incom 1 20 Not Started 
ACCTSYSCONF Accounting System Config15 Finanical & Finanical & 1 18Not Started 
ANNSALESUSEAnnual Sales & Use Tax  20 Analytical Pr Analytical Pr 16 Not Started 
ANNUALCOMPAnnual Compilation 25Workpaper Workpaper 14  Not Started
APRWRITEUPApril Writeup  30 Financial St  Financial St
AUDIT Audit  35 Financial St Financial St 8 Not Started 
AUDIT2 Audit2  40 Managemen Managemen 1  5  Not Started 
AUGWRITEUPAugust Writeup 45Assembly Assembly 3Not Started
BIWEEKPAYRLBi-Weekly Payroll  50 Delivery Delivery 1 1 Not Started
BUSAMENDTRBusiness Amended Tax R  55 Wrap Up Me Wrap Up Me 0 Not Started 
BUSTAXEXTBusiness Tax Extension
BUSTAXNOTICBusiness Tax NoticeAdd ip3 Delete

ÿ

ip3 Delete Import Default Proiect Templates J8103 Cancel 

For Help. press F1 Current Login: CAT Current Period: 4/1/2014 - 4/30/2014
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Firm setup 
To enable notifications: 

1. From the Setup menu, choose Firm. 

2. Click the Notifications tab. 

3. In the Project Management section, mark The Assigned on a Project changed 
checkbox. Then mark the Assigned checkbox so that the person to whom the 
project was reassigned will be notified. 

ark The due date on a Project changed checkbox. Then mark the 
Responsible checkbox to send a notification to the staff member designated as 
responsible on the project if the due date changes.  

5. Mark the Notify the Staff assigned to a Task that it is ready to be worked on 
checkbox. This will notify the staff assigned to the task that the task has been 
marked as “Ready” for them to work on. 

6. Click Enter to save your changes.   

 

User preferences 
As with other areas of the program, user preferences for the Project Management 
module are unique to each staff member. Because you are currently logged in as 
staff CAT, these user preferences will apply to staff Cindy Turner. 

1. From the Setup menu, choose User Preferences. 

2. Click the System tab. 

3. To receive desktop notifications whenever a monitored event occurs, mark the 
Enable desktop notifications for monitored events checkbox. 

Practice CS-[Sample]-[Fim]
Eile Edit YiewActigns Setup Iools Help
k·· PPY Search forassistance

Firm
Main Contact infoPreferencesBllng and A/RBeneftsTeminologyNotfications
Client

Monitored Event Noify Patrer Manager3qo
mal

The AR Limitwos exceeded ÿ
The WP Limt was exceeded ÿ ÿ

Project Management
Monitored Event Nothy RerponsbleAesigred

mal

The Assigned en a Projeet changed ÿ ÿ
The due date on a Project changed ÿ
The received date on a Project was ertered ÿ ÿ
AProjec was eended ÿ ÿ

Saff
A Project Task Staff changed ÿ
Notify the Staff assiged to a Task hatitis ready to be worked on ÿ

4. M
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4. Mark the Show desktop notifications until closed checkbox so that desktop 
notifications stay on screen until you close them.   

 
5. Click the Time & Expense Entry tab.  

6. Auto display Task selection: For this walkthrough, verify that this checkbox is 
unmarked. You would mark this checkbox to cause the Task Selection dialog to 
open automatically during time and expense entry whenever you select a 
project, allowing you to update project and task information while entering your 
time.  
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7. Mark the Start Timer for Projects checkbox to start a timer whenever you launch 
a solution from a project or task.   

 
8. Click OK to save the user preferences.  

Adding projects 
There are three main ways to add projects to a client in Practice CS: 

 Through the Manage Projects screen 

 Through the Projects tab of the Clients setup screen 

 Through the Edit multiple Clients link on the Clients setup screen 

You can add an unlimited number of projects to a client in Practice CS.  

Adding projects in the Manage Projects screen 
The Manage Projects screen provides a central location where you can view, sort, 
search, filter, and group projects and tasks for all of your clients in one place. If you 
have the appropriate security privileges, you can also add and update projects in 
this screen. 

1. From the Actions menu, choose Manage Projects. 
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2. Right-click and choose Add Project from the context menu.   

 
3. In the Project dialog, select client HANNA (Hanna, Jason) from the Client drop-

down list. 

4. In the Project field, select project ID 1040EX.  

Practice CS-[Sample]-[Manage Projects]
FileEdit ViewActions Setup Tools Help

Add

Manage Projects
ProjectsProect Tosks

Fiher Open Projects only

DgA

Cliert DescriponParentClientAddProject pagementDue ResponsidleAddProject tomultiple Clients
AasigpedOfice ExensionIsE

489BINGS Bing.Sally BINGTA VTAX 10/15/2Miller,SeveRogers.Meliss MICHIGAN
490HANNA Hanna.JasonHANNA Print Grid VTAX 4/15/20Rogers.MelisssRogers.MelisMICHIGAN
491JONESRJJones.Ron&JennJONESRU VTAX 4/15/20Rogers,MeliseRopers.MelissMICHIGAN

a Wllson Dan&JoaWILSON 1040SIMPLEIndividualncomeINDIVTAX4/15/20Turmer.CindyRogers.MelissMICHIGAN
509ABCP ABCParerhipABCP 1065 Partnership TaxRBUSINESSTAX4/15/20Mller,SeveMiler,SeveMICHIGAN

n
Ace AdvertisingACEADVERT1120 Corporle TaxRetBUSINESSTAX915/20Rogers.MelissaMiller.SteveMICHIGAN

511ALPHAAlpha PromobonsALPHA 1065 Partnership TaxRBUSINESSTAX4/15/20Rogers.MelissaMiller,SoeveMICHIGAN
512ANIMALAnimal Shelter 101ANIMAL 1041 Estateand TrustTBUSINESSTAX4/15/20Turner,CindyMiller.SeveMICHIGAN

Anderson,Joe&K 1040 Indvidual IncomeINOIVTAX4/15/20Rogers.MelissnRogers.Meliss
Miller.Steve

MICHIGAN
520BENTONBenton.StephanieBENTON1040 IndividualIncomeINDIVTAX4/15/20 Rogers.MelissMICHIGAN
521BINGTABing.Ted&AngelBINGTA 1040 IndividualIncomeINDIVTAX4/15/20Miler.SteveRogers.MelissMICHIGAN
522BROWNJ BROWNU1040 INDIVTAX4/15/20Miler.SteveRogers.MelissMICHIGAN
0 Golden,Michael&GOLDEN Indmndual IncomeINOIVTAX4/15/20Rogers,MelissaRoers.MelissMICHIGAN
525QUNN Quinn.Brian&MicQUINN 1040 IndhidualincomeINDIVTAX4/15/20Rogers.MelissaRogers.MelissMICHIGAN
526SMTH SmithTom&KahSMITH 1040 Individual IncomeINOIVTAX4/15/20Tumer.CindyRogers.MelissMICHIGAN
527CRANFORDCraword's SteakCRANFORD1040 Indvidal IncomeINOVTAX4/15/20Tumer.CindyRogers.MelissMICHIGAN
539AAC AdvancedAdverlis 1120 SCorporate Tax RBUSINESSTAX Miller.SteveMiller.SteveMICHIGAN

Hsory
H Order Descriptionletivity Target StartTarget CompleteTrackingStarted

For Help,pressF1 Current Login:CAT Curent Period 4/1/2014.4/30/2014
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ress the TAB key. Notice that the default information from the template 
completes the rest of the fields.   

 
6. Click the Tasks tab, and notice the four tasks that you set up on the project 

template. 

Project* X

Main Tasks LinksCustom Fields

Identification Target dates  Actual dates
Number: (Next Available) jeis 12/31/2014  Received:(none)
 Client: Hanna. Jason Complete:3/31/2015  Start: (none)
Project: 1040 Tax Return Example Complete:(none)

Description:1040 Tax Retum Example Due dates
US Individual lncome Tax RetumExtension:Not extendedInvoice Description:

Current:4/15/2015 4/15/2015

 Project information Groupings
 Engagement.Individual Tax Servicesÿ  Responsible: Rogers, Melissa
Priority: Normal Department:Tax Department
Tracking:  Not Started 

 Budget information Assigned

Base on Tasks Calculate amount automatically Staff:

Hours Amount
 Budgeted: 0.00
 Actual: 0.00 0.00

 Est. Remaining: 0.00  Reminder (none) (none)

% Complete: 0%ÿ Solution-

Generation  Select solution: 2013 UItraTax CS
 Completion event: Pattern: Due on every April 15 
 Extension event:Return Extension Filed

Notes

OK Cancel 

5. P
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7. Select Task 1 and click the Edit button.   

 
8. Under Budget information, enter 0.5 in the Hours field. The amount calculates 

automatically. 

Note: You can set up budget information for a project or for each individual task 
in a project. Budgeting allows you to later analyze your projects to improve 
project planning. 

9. Click OK to close the Task dialog. 

10. Click OK to close the Project dialog.  

Editing a project in client setup 
In the Clients screen, you can view all of the projects for each client. You can also 
add, edit, and delete project information here.  

1. From the Setup menu, choose Clients. 

2. Select client HANNA (Hanna, Jason). 

3. Click the Edit button. 

4. Click the Projects tab.  

Project* ÿ X

Main TasksLinks  Custom Fields

Order  DescriptionActivityActivity Description Target CompleteTracking  Started CompletedAs
1Client Meetings &CLIENTMEETClient Meetings &3/31/2015 Not Started Turner
 2PreparationPREPARATIONPreparation3/31/2015  Not Started
3Review REVIEW Review 3/31/2015  Not Started Turner

Assembly ASSEMBLYAssembly 3/31/2015  Not Started

PPV Edit Delete

OK Cancel

   

   

     
      

     
     

     

  

 



Setting up projects 

Practice CS Project Management WalkThrough 27 

5. Click the expand  button to the left of project 1040EX to display all tasks 
associated with the project.    

 
6. You have already assigned a staff member (CAT) and budgeted task 1 for this 

project. Edit the remaining tasks as follows by selecting each task and clicking 
the Edit button. 

Note: You can also right-click each task and choose Edit Task from the context 
menu. 

Order Activity Staff Budgeted 
Hours 

Budgeted 
Amount 

reparation PW 0.5 112.50 

eview CAT 0.25 56.25 

4 Assembly MHR 0.25 56.25 

7. When finished editing each task, click OK to close the Task dialog. 

lick Enter to save the updated project information. 

Practice CS-[Sample5]-{Clients]

Clients
earch 2

Descripbon MainCortact roEngogementsProjectsDingndA/RUnksCustmFeldsNotesHtoy
AAC Advanced Advertising Cons
ABCP ABCParnership Open Projects only
ACEADVERAceAdvertising

ÿ Tracking Target CompleteRespoesibleAasigre

PaneALPHA AphaPromobons ? ÿ 851040 Completed3212011 Rogers.Melisa

ÿ
smth.Jee

ANDERSOAnderson.Joe &KGm 000L002 Individual incomeTax ReturnINOIVTAX 5/302012 Rogers,MelssaRogers,Mel

bnn
ANMAL Animal Sheter101 1040Exlersion INDIVTAX Completed 4/6/2012 Rogers.MelisaSmth.Jen

BENTONBenton Stephanieÿ 3201040 Individual Income Tax Return Completed 35/2013 Rogers.MelisaRogers,Mel

BINGS lues'urg
4901040SIMPLIndividual Income Tax ReturnINOIVTAX Started 4/15/2014 Rogers.MelissaRogers.Mel

BINGTA Bing.Ted &Angela
5521040NOTICIndividual Tax Notice INDIVTAX Started 4/3/2014 Rogers.MelissaRogers,Mel

BROWNJ BrownJerald &Elizabeth X30019 1040Tax Return ExampleINOIVTAX 3/31/2015 Rogers,Melissa
CRANFORCrawfordsSteak House ÿ Order Descrigtion Activity Activity DescripionTarget CompleteTracking

1Clent Meenge &
Assigned

N3O10DGolden.Michael &Meredih CLENTMEET 331/2015 Not StartedTurner,Cindy
HANNA Harn.Jason 2Preparabon PREPARATIONPreparabon 331/2015 Not Starled
JONESRJJonesRonJeny 3.Review REVIEW Review 3/31/2015 Not Started Tuner.Cindy
MANSFIELMansfeld,Edward& Sylvia 4Assembly ASSEMBLYAosembly 331/2015 NotStarted
PROTO Prototype Design
PVM Pames,Velano.Marinez&

ÿ 760 Collins,Browm&Lewis Adv
Quinn,Brian &Michelle

SMITH SmhTom&Katheen
WILSONWwflson. Dan &Joanne

6dd Edt Delete

Add Eas Dejete Editmuliple Clhents Eger Cancel

For Help.pressF1 Current Login:CATCurentPeriod:4/1/2014-4/302014

2 P  J

3 R

8. C
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Adding a project in client setup 
You can also use the Projects tab of the Clients setup screen to add projects. The 
Projects tab lets you create a client’s projects while you are entering their other 
setup information. Also, if you have associated project templates with the entity that 
you use for setting up the new client, the program will prompt you to add the 
associated project template(s) when you select the entity. 

1. In the Clients setup screen, click the Add button. 

2. In the ID field, enter NEWCLIENT. 

3. In the Entity field (in the Groupings section), select CCORP.  

4. Press the TAB key. Practice CS will prompt you if there are project templates 
associated with the client entity you have selected.  

The C Corporation entity is associated in the program with the 1120 project.   

 
5. Click OK. 

Project Templates

ID Description ID Description
706 Estate Tax Return 1120 Corporate Tax Return
709 Gift Tax Return
941 941 Employer's Quarter Fe
990 Not For Profit Tax Return
1040 Individual Income Tax Retu
1040ES 1040 Estimated Tax Paym
1040EX 1040 Tax Return ExampleSelect >
1040EXT 1040 Extension
1040NOTICIndividual Tax Notice Select All >>

1040SIMPLIndividual Income Tax Retu
1040TAXPLIndividual Tax Planning<Remove

1040X Amended Individual Incom<<Remoye All
1041 Estate and Trust Tax Retur
1065 Partnership Tax Return
1099 1099
1120S S Corporate Tax Return
1120w 1120 Estimated Tax Paym
ACCTSYSCAccounting System Config
ANNSALESAnnual Sales & Use Tax

QK Cancel

 

    
    
  
  
  
  

  
   
  

   

  
   

   
  
  
  

  
  

  
  

 



Setting up projects 

Practice CS Project Management WalkThrough 29 

6. Click the Projects tab, and notice that the 1120 project has been added for the 
new client.    

 
7. Click the Engagements tab and notice that the BUSINESSTAX engagement 

has also been added to the client because this is the engagement on the 1120 
project template. 

8. For this exercise, do not save the new client. Click the Cancel button.  

Editing multiple clients 
The Edit multiple Clients feature provides a quick way to add one or more projects 
to many clients at one time during client setup. 

Note: You can also add engagements to multiple clients with this feature. 

The following exercise illustrates how to add projects to multiple clients. 

PracticeCS-[Sample]-[Clients"]
Ele Edit View Actigns Setup IoolsHelp

Aod

Clients
arck

ID Descniption Man Contact ifoEngagemertsProjectsBingandA/RLnkaCutmFedaNotesHoy
AAC AdvancedAdvertising Co
ADCP ADCParnership Open Projects only

ACEADVEAceAdverising Project Project Description EngagementTrackingTarget CopleteResponsibleAssigoed
ALPHA AlphaPromotons (NedAva1120 Corporate Tax ReburnBUSINESSTAXNot Staried

PaneANDERSOAederson,Joe&Km
ANIMALAeimal Sheer 101
BENTONBenton.Stephanie
SDNE Bing.Sally
BINGTABing.Ted &Angela
BROWNJBrownJerd&Eizabt
CRANFOCrawfords Stesk House
GOLDENGolden,Michae&Mered
HANNA Hanna.Jason
JONESRJJones,Ron &Jenny
MANSFIELMansfeld.Edwrd&Syvi
PROTOPrototype Design
PVM Parnes.Velano,Mainez
QBL Collins.Browm&LewisA
QUINN Quinn,Brian&Michelle
HLINS Smith.Tom&Kathleen
WILSON Wllsn Dan&Joae

1

Sdd Delece
ddd Edt Delete Edtmulle Clients Erter Cancel

For Help.press F1 Current Login:CATCurrentPeriod4/1/2014-4/302014
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1. In the Clients setup screen, click the Edit multiple Clients link at the bottom of 
the screen.   

 

2. In the Edit Multiple Clients dialog, click the Add Projects option.  

3. Click Next.   

 

Practice CS-[Sample]-[Clients]
EleEdit ViewActignsSetup IoolsHelp

Add

Clients
karch

ID Description ManCortacfoEngaesPrectBng and /RLnkaCumFedNoesHy
AAC AdvancedAdvertisingCo
ADCP ADCParnership Idenifca5on
ACEADVEAceAdverising ID: HANNA EINSSN:
ALPHA Alpha Promotions

777-77-7777

ANDERSOAederson,Joe&Km Descrigtion:

Pane
Haeea,Jason

ANIMALAeimal Sheer 101Name1: Jason Hanna
BENTONBenton.StephanieName2
SONG Bing.Sally FirstName: Last Name:
BINGTABing.Ted &Angela
BROWNJBrown,Jerld&Eizabeth

Individual:Jason Hsena
CRANFOCrawfords Stesk HouseSpouse.

Golden.Michoel & Mered Spouse SSN:
HANNA Hanna.Jason Cloent nfomaon

Jones,Ron&Jenny
Groupinga

JONESRJ
MANSFIELMansfeld.Edwrd&Syvi

Class: Client Office: Michigan Olfice
PROTOPrototype Design Status: Active Partrer: Rogers.Melissa
PM Parnes.Velano,MarinezStart 1/1/2011 ÿ Marager:
QBL Collins.Brown &LewisA
QUINN Quinn,Brian&Michelle

Lett: (none) Associate:

HLINS Smith.Tom&KathleenFYE December Ersty IndividualEnsty
WILSONllsonDan&Joane WIP Limit. 000 Industry Code:

A/R Limit 0.00

Add Ed Delete
For Help.press F1 Current Login:CATCurentPeriod4/1/2014-4/302014

Edit Multiple Clients-Add Projects

Choose how you would like to edit your Clients:

Add Engagements

Add Projects

O Change Client information

Change Engagement information

 Merge Clients

Back Next Finish Cancel
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4. In the left pane of the dialog, click each client to which you want to add projects 
and then click the Select button. For this exercise, select clients ACEADVERT 
(Ace Advertising) and ALPHA (Alpha Promotions).   

 

Notes 

 To select multiple clients in the list at once, hold down the SHIFT key and 
click each client with your mouse pointer. To select non-consecutive clients 
in the list, hold down the CTRL key and click each client with your mouse 
pointer. 

 If you want to select all of the clients in the list at once, click the Select All 
button. 

 Click the Remove or Remove All button to remove clients from the list of 
selected clients. 

5. Click Next.  

Edit Multiple Clients - Add Projects

Select the Clients you would like to add Projects to:

Search ÿ

ID Description ID Description
AAC Advanced Advertising Consultan ACEADVERT Ace Advertising
ABCP ABC Partnership ALPHA Alpha Promotions
ANDERSON Anderson, Joe & Kim
ANIMAL Animal Shelter 101
BENTON Benton. Stephanie <paa
BINGS Bing. Sally
BINGTA Bing. Ted & Angela Select All >>
BROWNJ Brown,Jerald &Elizabeth

CRAWFORD Crawford's Steak House <Remove
GOLDEN Golden, Michael & Meredith <<Remoye All
HANNA Hanna, Jason
JONESRJ Jones, Ron & Jenny
MANSFIELD Mansfield, Edward & Sylvia
PROTO Prototype Design
PVM Parnes,Velano, Martinez & Co.
nRI Callins Rroun &.Iauis Adhr

<Back Next > Finish Cancel
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6. In the left pane, double-click each project that you want to add to the clients you 
have selected. For this exercise, double-click the AUDIT project.   

 
7. Click the Finish button to add the project to the selected clients.  

Note that this project now appears on the Projects tab for each client.   

 

Note: You can also access the Edit Multiple Clients dialog from the Manage 
Projects screen (Actions > Manage Projects) by right-clicking and choosing Add 
Project to multiple Clients from the context menu. 

 

Edit Multiple Clients - Add Projects

Select the Projects you would like to add to your Clients:

Search
ID Description ID Description

1099 1099 AUDIT
1120 Corporate Tax Return
1120S S Corporate Tax Return
1120w 1120 Estimated Tax Payments
ACCTSYSCONFAccounting System Config Select >
ANNSALESUSEAnnual Sales & Use Tax
ANNUALCOMPAnnual Compilation Select All >>

APRWRITEUPApril Writeup
AUDIT2 Audit2 <Remove
AUGWRITEUP August Writeup <<Remoye All
BIWEEKPAYRLBi-Weekly Payroll
BUSAMENDTR Business Amended Tax Return
BUSTAXEXT Business Tax Extension
BUSTAXNOTICBusiness Tax Notice
BUSTAXPLAN Business Tax Planning
CONSIII TING Cansulfinn

<Back <xaN Finish Cancel

[PracbiceCS-[Samplet]-[Clients]
EileEoit ViewActions SetupIools Help

ck··# PPV

Clients

eerch
ID Deseription ManContactfoEngagementsPrjectsing nd A/RnksCumFeidsNcsHty

AAC Advanced Advertising Co
ABCP ABCParnership Open Projects only

ACEADVEAceAdverbsing Prejet DescripionEngagementTracking
3/11/2011
Target CompleteResponaible Aasigned

ALPHA Alpha Promoties

ÿÿÿÿÿÿ
411065 Partnership Tax ReturnBUSINESSTAXCompleted Rogers.MelissaJohnson.Kmberl

ANDERSOAnderson,Joe&Km
421065 Partership TaxRetur

Pane
BUSINESSTAXCompleted 35/2012 Rogers.MelissnJohnson,Kmberl

Animal Sheller 101 43BUSTAXPLDusiness Tax PanningANIMAL
BUSINESSTAXCompleted 12/30/2011Rogers,MelissaJohnson,Kimberl

NOIN 66VALUATIOBusiness Valabon CONSULTINGCompleted5/23/2012 Rogers.MelissaMller.Seve

uogeBing.Sally 192CONSULTI CONSULTING 8/31/2011 Rogers.MelissaJehnson,Kimberl

BINGTABing.Ted&Angela 212TAXCOMPTax Compilation BUSINESSTAXCompleted ZOZ Rogers,Melisss
BRONI BrowJerald&Elizabeth Accounlng System ConfigCONSULTINGCompleted 7/20/2012 Rogers.MelissaMiler.Seve
CRAWFOCrewford'sStesk Houseÿ 2951065 Partership Tax Retun Completed 4/12/2013 Rogers.MelissaMiller,Seve
GOLDENGoldenMichael&Meredÿ 296BUSTAXPLDusinessTax Planning Completed 12/12/2012Rogers,MelissaMiller,Steve

HANNA Harna.Jason ÿ 416TAXCOMPTaxCompilaton Comoleted3/11/2013 Rogers.MelisssMiler,Steve
JONESRJJones,Ron&Jenyÿ 434BUSTAXPLBusess Tax Planng Completed 12/6/2013 Rogers.MelssaMiller.Sleve

MANSFIELMansfeld.Edwrd&Syi 5111055 Partership Tax RetumBUSINESSTAXNot Started4/10/2014 Rogers.MelisssMiller,Seve
PROTOProlotype Designÿ 545TAXCOMPTax Compilation Comcleted3/17/2014 Rogers,MelissaMiller,Steve
PVM Parnes,Veno,Mtiÿ 589CONSULTIConsulang-Web Design Update Completed4/17/2014 Rogers.MelissaMller.Seve
QBL Collins,Brow&LewisA+ 596AUDIT Audit AUDIT 222/2015

QUINN Qn.Bran&Mchelle
SMITH Smith.Tom&Kathleen
WLSONnilson,Dan&Joane

#

Add Ede

Add Ed Delate Editmutiple Clients Eler Cancel

For Help.pressF1 Current Login:CATCurrentPeriod:4/1/2014-4/30/2014

 

 

 

    
   
  

  
  

   
  

   

 
   

   
 

 
  

  
  

  

  

 
 

  

 

 
    
  
  

 

     
 

   

  
 

     

  
  

 

     

        

       
 

   
 

  

    
 

 

        
         

        

         

         
         

  
       

        
  

     

  
 

 

 

  

      



 

Practice CS Project Management WalkThrough 33 

Managing Projects 
In this chapter, you will learn about the different areas of Practice CS from which 
you can manage your firm’s projects: 

 Clients screen 

 Manage Projects screen 

 Client Dashboard 

 Staff Dashboard 

Managing projects in client setup 
You can use the Clients setup screen when you want to see all of the projects for a 
particular client.  

Viewing all projects and tasks for a client 
1. In the Clients setup screen, select client AAC, Advanced Advertising 

Consultants, from the selection list. 

2. Click the Projects tab.  
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3. To see all of the tasks associated with this client’s latest AUDIT project, click 
the expand  button to the left of project #432.    

 
As discussed on page 26, you can use the Clients screen to add, edit, and 
delete project and task information for clients if you have the appropriate 
security privileges. For this exercise, do not make any changes to the client. 

Note: If your firm uses the security features in Practice CS and has multiple 
offices, the ability to view project data for engagements in other offices can be 
restricted through security. For more information, see the topic More about 
security privileges in the Practice CS Help & How-To Center. 

Managing projects in the Manage Projects screen 
In the Manage Projects screen, you can sort, group, and filter the lists of projects 
and tasks to make it easier to find the information you want to work with. In this 
screen, you can: 

 lick a column header to sort the list by that column 

 roup projects by clicking and dragging a column header to the upper section 
of the screen where it reads “Drag a column header here to sort by that 
column.” 

 roup by multiple columns by dragging additional column headers to the upper 
section of the screen where it reads “Drag a column header here to group by 
that column.” 

 xpand the details within your grouping by clicking the  button. 

The following exercises will illustrate working with project information in the Manage 
Projects screen. 

[Practice CS-[Sample5]-[Ciens]
Eile Edit yew Actins Setup Iools Hep
Bak·· ÿ

Clients
ÿ?

DescrigbonManContact EngaeensProjectsDingand A/RunksOunFeNtsHy
ADCP ADCParnershio Oe Prct oly
ACEADVERAce Adrerisinge Project DescrighonEngegementTrackingTarget CompleteResponsibleAeignedlsEended
ALPHA Alpha Promotons

432AUDI Aud AUDET CO 26/2014 Mler-Steve e

Anderson.Joe &Kim B DescigtoeReady AcsivityActivity DesciponTarget CompleeTrackingAasignedInWorkQueueStafQualis
ANIMALAnimal Sheter101

5Engageent Let
1ign&Bude ASSIGNBUDlsign&Bude1082013 ComgletedMiller.Sev

BENTONDeton.Seghanie R 10102013 Completed
Mlir.Sev
Milr Steve

BINGS Bing.Sally 5Pre-lescalPo PREANALYTICPe-lcProse102014 Comgleted
BINGTABing,Ted&Angela 5Risk Aasesmet RISKASSESSFiskAssessmeetCo102014Completed

5Moues Merubes
Miller.Steve

BROWINJ MINUTES ComgletedMller.Sove

PaneCRANFORCrawfords Stek Mouse 10Cah CASH Cash 282014 ComgletedMilr Seve
NGOODGolden Michal&Mered ACCOUNTREClocounts Recevl202014 ComgletedMilr. Sheve

uogebAeN
HANNAHanra.Jason 10inventory INVENTORYInventory 28/2014 ComgletedMiler.Sove
JONESRUJoes.RonJeny 10P&r PREPAOSPrepads&Oer Cu282014 ComgletedMiler.Stev
MANSFIELMaeicEdwS 10Propty.EqupmPROPERTYProperty.Eqipment282014 CompletdMiler.Steva
PROTOProtctype Design 10NoesPayale NOTESPAYNoesPayable20/2014 ComgletedMile.Soeve
PVM Pares.Veano,Marinez 10Accounts PayableACCOUNTSPAYAccouns Payable282014 CompletedMiller.Steve
QBL Collins.Brown&Lewis Adv 10Oher Curent LaOTRCURLIAD ComgletedMiler.Steve

Quinn Brian&Michelle 10/Equity EQUITY Equty 202014 ComgletedMiller.Steve
SMTH Smith.Tom&Kameen 10IncomeTaxes INCOMETAXInoome Taxes202014 ComgletedMiler.Steve
WILSONison,Dan&Joane 10Revenues REVENUESRevenues282014 CompletedMiler.Steve

10General.Admin,GENADMINSELGeneral.Admn,&S202014 Comgleted Miler.Steve
10Other comeandOTHERINCEPOtherIncome and E202014 CompletedMiler Steve
15Finaical&TaxDFSTRANDDEFFinanical &Tax Dele2/10/2014CompletedMiller.Sheve
20Analytical ProoedANALYTICALAnlyicalProcedure2/122014 ComgletedMilr.Steve
25Wrkpper ReieWPREVEWWorkgaper Review2/142014 ComgletndMiller.Steve
30Financial SttmeFSPREP FinancialStatemert2/172014 CompletedMiller.Sheve
35Financial StatemeFSREVEWFinancial Statemert220/2014 ComgletedWillson.Jeff
40Maragemert RegMGTREPLETERManagementRep L223/2014 ComgletedMiler.Steve
45Aasembly
50Delvery

ASSEMDLYlesembly 225/2014 ComgletedRogers.Melissa
DELVERYDelivery 2272014 CompletedRogers.Melissa

55ap Up MeengWRAPUP Vrap Up Meeting2/20/2014 CompletedMller.Seve
ÿ Project

Bsieess Tax Plaing
EngagementTackingTargetComplete

Miler.Seve
Responsible Aesigned

471BUSTAXPL BUSINESSTAXCompleed12/1/2013 Miller.Steve
Is Exended

Bdd ÿ

bsd Fd Danoel

Fr Help.pressF1
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Sorting and grouping the Manage Projects screen 
1. Choose Actions > Manage Projects. 

2. Click the Assigned column heading to sort the list alphabetically by the 
assigned staff members’ names. 

Note: If you want to sort the list by a column heading in descending order, click 
the heading again. Click it a third time to remove the sorting.   

 
3. To group the list by assigned staff, click the Assigned column heading and drag 

it to the box containing the text Drag a column header here to group by that 
column.   

 

PracticeCS-[Sample5]-[MangeProjets]
EileEdt Yiew Acbgns Setup Iools Hep

Manage Projects
ProjectsTasks

Open Projects only

Brota

ClientID CliertDescnipionParentCliertProject Project DescnipionEngagement
1040EX

Due ResponsibleAssigned Office Extension Is ExtendedPriotty
G13HANNA Hanna.Jaecn HANNA 1040TxRetnE INDIVTAX 15/20 Rog ra.Melissa MICHIGAN Nom
614ACEADVERTkee AdverisingACEADVERTAUDIT Audt AUDIT 331/20Rogers.Melissa

AUOIT
MICHIGAN Nomal

615ALPHA AlphaPromotonsALPHA Audi AUDIT 331/20Rogers.Melisa MICHIGAN Nomal
509ABCP ABCPannershipABCP 1065 Paehip TaxRBUSINESSTAX415/20Milr.SnveMiler.SeveMICHIGAN
510ACEADVERTAceAdverisingACEADVERT1120 Corporte Tax Ret Rogers.MelissaMiler.SteveMICHIGAN

ALPHA Rogers.Melisa
Normal

511ALPHA AlphaPromotions 1065 Parership TaxR DUSINESSTAX4/15/20 Miler.SteveMICHIGAN Normal
512ANMALAnmalSheller 01ANIMAL 1041 Estle and TrstTBUSINESSTAX4/15/20Turner.CindyMiller.SeveMICHIGAN Normdl
535AAC Advanced AdvertisAAC 11205 BUSINESSTAX Miler.SeveMiler.SteveMICHIGAN
489BINGSBing.Saly IndividualIncome Miller.SoeveRogers.Melis

Normal
BINGTA 1040SIMPLE INDIVTAX10/152 MICHIGAN Normal

490HANNAHanna.JasonHANNA 1040SIMPLEIndiviualIncomeINDIVTAX4/15/20Rogers.MelissaRogers.MelissMICHIGAN Normal
491JONESRJones.Ran&JennJONESRJ1040SIMPLEIndividual incomeINDIVTAX 4/15/20Rogers.MelissaRogers.Melis

WlonDan&Joe Indvidualncome TuenerCindy
MICHIGAN Normal

492WILSON NOSTM 1040SIMPLE INDIVTAX4/15/20 Rogers,MelissMICHIGAN Normal
519ANDERSONAnderson.Joe&KANDERSON1040 Individual lncomeINDIVTAX 4/15/20Rogers.MeliaRogers MelissMICHIGAN

Beton Sphanie IndvidualIncomeINDINTAX RogersMelisMICHIGAN
Normal

520BENTON BENTON 1040 4/15/20Ml.S Normal
521BNGTA Bing,Tod&AngelBINGTA 1040 IndividuallncomeINDIVTAX4/1520Mier.SveRogersMelissMCHIGANNormal
522BROWNJ DROWNU 1040 INDIVTAX 4/5/20Miler.Seve

415/20Ros.MeissRogers.MelssMICHIGAN
Rogers.MelissMICHIGAN

Indvidual Income
Normal

524GOLDENGolden.Mchoel &NB00S 1040 Normal
SRAR. UARRS

TargetComgleteTacking
Ciert Meeings&

Comgieed
ÿ CLIENTMEETTurner.Cindy12312014331/2015 Nt Stared

2 PreporatonPREPARATIONwilson.Jeff 12/31/20143/31/2015 NotStaned
3 Review REVIEW Turner.Cindy331/2015331/2015 NotStarted
4 Aasembly ASSEMBLYRogers.Melisso331/2015331/2015 Not Slarted

For Help.pressF1 Cument Login:CATCurrent Period:4//2014-430/2014

Manage Projects
Projects Project Tasks

Search

Filter Open Projects only

Drag a column header here to group by that column Assigted

# Client ID Client Description Parent Client Project Project Description Engagement Due Responsible Assigned Office Extension IsExtended Priori
527 CRAIWFORD Crawford's Steak CRAWFORD 1040 Individual Income INDIVTAX 4/15/20 Turner. Cindy Rogers, Meliss MICHIGAN
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4. Click the expand  button next to Melissa Rogers to view her assigned projects.    

 
5. Now drag the Due column header to the top of the screen next to the Assigned 

header. This groups the list of projects by assigned staff, then by due date. 

6. Click the expand  button next to Melissa Rogers, then for due date 4/15. You 
can see that this staff member has several projects due on 4/15. 

7. Click project number 527 for client Crawford’s Steak House. The tasks 
associated with this project appears at the bottom of the screen.   

 

8. To “ungroup” the screen, drag the Assigned and Due headers back to the grid. 

[Practice CS-[Sample5]-[Manage Projects]
EileEdit Yew Acins Setup Iools Hep

Add

Manage Projects
ProjnctsTasks

Open Projects only
Aosigred

ÿ ClientIDClient DescriponParentClientProjeetPrejeet DescrigtionEngsgemertDue ResponsitleAasignedOttice Extension ls ExtendedPr

Assined:(3iemsÿ
AssigedMllerSeeÿ5items)

Pane489BINGS Bing.Sally BINGTA 1040SIMPLEIndividuslncome
1040SIMPLE

INDIVTAX
490HANNAHanna.Jason Individual income

10/15/2Miller.Steve
Rogers,Melss

Rogers,MelissMICHIGAN
HANNA INDIVTAX4/1520 Rogers.MelissMICHIGAN Nor

Nor

491JONESRJJones.Ron&JenJONESRJ1040SIMPLEIndividual IncomeINOIVTAX4/15/20Rogers.MelisssRogers.Meliss
10405MPLE

MICHIGAN
IndividualIncome Rogers.Meliss

Nor
492WILSON Wilson.Dan&JoaWILSON INDIVTAX 4/15/20Tumer.Cindy

Individusl Income
MICHIGAN Nor

519ANDERSONAndersn Joe&KANDERSON1040 INDIVTAX4/15/20Rogers,MelissaRogers.MelissMICHIGAN
Indriduel lncome Miler.Sleve

Nor
520BENTONBenton Stechanie 1040 INDIVTAX4/15/20 Rogers,Meliss

Mille,Seve
MICHIGAN

Individuslincome 4/1520
Nor

521BINGTABing.Ted&AngelBINGTA 1040 INDIVTAX Rogers,Meliss
Individuallncome Miller.Steve

MICHIGAN Nor
522BROWNJDrown.Jerald &EiDROWN 1040 INDIVTAX4/15/20 Rogers,Meliss

1040
MICHIGAN

Golden Michal
Nor

524 GOLDEN IndivdualincomeINOIVTAX 4/1520Rogers.MessaRogers.MelissMICHIGAN Nor
525QUINN Quinn Brin&MicQUINN 1040 IndvidualncomeINDIVTAX4/15/20Rogers,MelisssRogers.MelissMICHIGAN

Individuallncome
Nor

526SMITH Smh.To&Ka SMITH 1040
Individual income

INDIVTAX 4/15/20Tumer.CindyRogersMelissMICHIGAN
Tuener,Cindy

Nor
527CRANFORDCraafordsSkCRAVFORD1040 INDIVTAX 4/1520 Rogers,MelisMICHIGAN Nor
O99 Browerd&ElBROWN1040ES 1040Esimated TaINOIVTAX4/15/20Miler,SteveRogersMelissMICHIGAN

HANNA 1040NOTICE 44201Rogers.Melisss
Nor

592HANNA Hanna.Jason
1040ES

Individual Tax Noi
INDIVTAX
INDIVTAX Rogers.Meliss MICHIGAN

6/1620Miler.Seve
Nor

597BROWNJBrow,Jerald&ElBROwN 1040EsmedTa Rogers.MelissMICHIGAN Nor
Aasigned:Tumer,Cindy (33items)

ToskisHsoy
Order Descripion Aetiviy AssignedTarget StanTargetCompleteTrackingStartedCompleted

For Help prssF1 Current Login:CAT Current Period:4/1/2014-4/30/2014

[Practice CS-[Sample5]-[Menage Projects] X

EleEdit Yew Acbgns Setup Iools Help
Add

Manage Projects
Taka

ÿ
Open Proects only

AasignedDue

Client DescriptionParentClientProjectProject Descripion Due Resporaiblelasiped Offce Extension ls ExtendedPrioni
Assigred:(2i)
AsigredMille.Soee(2im)
AssigredÿRogers,Melissa(4iems)
Oÿ442014ÿ1mÿ

n
490HANNA HANNA 1040SIMPLEIndividual IncomeINDIVTAX415/20Rogers.MessaRoerMelissMICHIGAN
491JONESRJJones,Ron&JennJONESRJ1040SIMPLEIndividusl IncomeINDIVTAX4/15/20Rogers MelisaRogens MeisMICHIGAN
492WILSON

Normal
wso,Dan&JoeWILSON 1040SIMPLEIndividual IncomeINDIVTAX4/15/20Tormer,CindyRogersMliss MICHIGAN

1040 4/15/20Rogers.MeissaRogers.Mss MCHIGAN
Normal

520BENTON
519ANDERSONAnderson Joe&KANDERSON Individual IncomeINDIVTAX

Benton,StephanieBENTON1040 IndividualIncomeINDNTAX4/15/20Miler.Sve
415/20Mler.Stve

Rogers.Meliss MCHIGAN Normal
521BINGTABing.Ted &AngelBINGTA 1040 Individual IncomeINDIVTAX RogsMlies MCHIGAN
522BRONJ BrowmÿJerald&BROWNJ 1040 IndividualincomeINDIVTAX4/15/20Miler.Seve

Goden Mchal& Indvidual Income
Rogers.Meiss MICHIGAN

INDIVTAX415/20Rog.Melasa
Normal

00 GOLDEN RoerMlMICHGAN Nor
525QUINNQuinn,Brin&MicQUINN 1040 Individusl IncomeINDIVTAX4/15/20Rogers,MelissaRogers.MelissMICHIGAN Normal
526SMTH Smith.Tom&KathSMTH 1040 IndviouslincomeINDIVTAX415/20Tumer,CindyRogersMess MICHIGAN Normal

CRAWFORD CRNNFORD1040 redveual INDIVTAX
4/15/20Mler.Seve
4/15/20

1040EsmatedTa
Roo MICHIGAN

999BROWNJ BROWN3 1040ES Rogers.MelissMICHIGAN
Due:5/16/2014ÿ1itmÿ

TasksHetory
Prjet5271040-InividullcoeTaR

ÿ ÿ Order lasigned Target StartTargecCompleteTrackingStartedCompleed
ÿ 1 Clent Meengs& Rogers.Melissa

Rogers.Melissa
NotSerled

2 Ifomation/ScINFOINSCAN Not Stared
3 PreperationPREPARATIONRopers.Meliss

Reiew WilsonJeff Not Staned
Not Stared

4 REVEW
5 Clear Review CoCLEARREVEWMiller.Soeve

Final Revew
Not Staried

FINALREVIEWRogers.Melisse Not Sterled

ForHelp,pressF1 Current Login:CATCurrent Period4/1/2014-430/2014
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Notes  

 You can double-click the row for a project or task to open the project or task 
dialog, respectively. 

 These same grouping and sorting options are also available in the Project 
Tasks tab. 

Filtering the list of projects 
You can filter your list of projects by any of the items in the Filter drop-down list, 
which contains most of the fields in the Manage Projects screen. Filters can be 
useful for working with projects by allowing you to focus on particular aspects of the 
project. For example, you can see: 

 all projects for a single client 

 what projects are due within a certain timeframe 

 workload for a particular staff member 

 how many projects you have of a particular type 

 how many projects are at a particular stage 

In the following exercise, you will use a filter to view all projects that are due within a 
particular date range.  

Note: For this exercise, make sure that you have removed all groupings from the 
Manage Projects screen. 

1. If necessary, click the Show Filter button to expand the filter area.   

n the Filter field, select Due Date from the drop-down list.   

 

Practice CS-[Saple5]-[Manage Projects]
FileEdit Vew Actons Setup Tools Hep

Add

Manage Projects
Taska

Description
DepartmentID
Department Name
Due Date

Project Engagemert
10/152MalerSteve

Due ResponsibleAatigned Ofce Edension Is ExendedPriarty
Ergagemect 1040SIMPLEIndividual IncomeINDIVTAX Rors.Miss MCHIGAN1 V Normal

1040SIMPLEIndvidual IncomeINDIVTAX4/15/20Rogers.MelissaRogers.MelissMICHIGAN Noral
EngagementTemgiate Name 1040SIMPLEIndvduel IncomeINDIVTAX 4/15/20Rogers.MelissoRogers.MelisMICHIGAN Normal
Extersion Number 1040SIMPLEIndividual IncomeINDIVTAX4/15/20Turner.CindyRogers.MelissMICHIGAN Normal

PaneGoFileRoomWlorkflow 1065 ParershipTax RBUSINESSTAX4/15/20Miler,SteveMller,SteveMICHIGAN
510ACEADVERT

Normal
beeAdveritingACEADVERT1120 CorpoeTax RetBUSINESSTAX9/1520Rogers.MelissaMller.SteveMICHIGAN Normal

n
511ALPHA ALPHA 1065 Parnership TaxRBUSINESSTAX4/15/20Rogers. MeissaMiler.Sheve

Miler.Seve
MICHIGAN Normal

512ANIML Arimal Shelter 101ANIMAL 1041 Estate andTrustTBUSINESSTAX4/15/20Turer,Cndy MICHIGAN Normal
519ANDERSONAndersonJoe &KANDERSON1040 Individual IncomeINDIVTAX4/15/20Rogers.MeliosaRogers.Meliss

Rogers.Meliss
MICHIGAN Normal

N02 Benton,Stephanie 1040 Individuol IncomeINDVTAX 4/1520Miler.Steve MICHIGAN Normal
521BINGTA Bing.Ted&AngelBINGTA 1040 Individual IncomeINDIVTAX4/15/20Miler.SteveRogers.MelissMICHIGAN
522BRON 4/15/20Mller,SeveRogers.Meliss

Normal
g BROWNJ1040 Individual IncomeINDIVTAX MICHIGAN

524GOLOENGolder.Mcha 
Normal

GOLDEN 1040 Individual IncomeINDVTAX 4/1520Rogers,MeissaRogers.Meliss
525QUINNQuinn,Brian&Mc

MICHIGAN Normal
QUINN 1040 Individual IncomeINDIVTAX4/15/20Rogers.Melissa

Tuner.Cndy
Rogers.MelissMICHIGAN Normal

526SMITHSmth.Tom&KathHIINS 1040 Indvduel lncomeINDIVTAX4/15/20 Rogers.Meliss
4/15/20Tuener.CindyRogers.Meliss

MICHIGAN
CRANFORD CRANFORD

Normel
1 527 1040

AdvancsAder SCoteTxR
Individual IncomeINDIVTAX

Mile,Steve
MICHIGAN Normal

609AAC AAC 1120S BUSINESSTAX9/15/20Mile,Steve MICHIGAN Normol
560ACEADVERTDce ldeitingACEADVERTMARWRITEUPMarchwoitepACCOUNTING4/30/20Rogers.MeisaTurrer,CindyCALIFORNIA

Ace Adverising
Normal

563ACEADVERT ACEADVERTMONTHPAYROMoeely PayrollPAYROLL4/30/20Rogers. MelissaTumer.CindyMICHIGAN Normal
ÿ

Tasks

ÿ Order Icirity AssignedTget StartTarget CompleteTrackingSanedCongiennd
ÿ

ForHelp,pressF1
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3. In the additional fields, make the following selections.   

 
4. The Manage Projects screen now shows only those projects that are due in the 

current period.    

Note: Marking the Open Projects only checkbox at the top of the screen filters 
out any projects that are completed or canceled. 
 

 

5. Click the  button to remove the filter.    

Note: To improve performance in Practice CS wherever large lists of items are 
displayed, results are limited to a pre-determined maximum size. When a dropdown 
list displays results that are limited, the message “Results limited” appears at the 
end of the list. 
 

 
 

If the data you are looking for is not included in the limited results, refine your sort 
order, search criteria, and/or filter to narrow down the data displayed in the list. To 
display more items in the drop-down list, click the Get More Items button.   

Editing a project in the Manage Projects screen 
To edit project or task information in the Manage Projects screen, right-click a 
project and choose Edit Selected Projects from the context menu. 

1. Right-click the MARWRITEUP project for client Ace Advertising (project 560). 

Results Limited Get MoreItems 
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2. From the context menu, choose Edit Selected Projects.   

 
3. In the Project dialog, you can update the project information as needed. Under 

Actual dates, enter 4/8 in the Start field.  

[Proctice CS-[Sample5]-[Manage Projects] X

HileEdit Wew Actons Setup Tools Hep
Add

Manage Projects

Open Ptoectonly

CliertID Client DescripionParent ClientProjectProject DeserpionEngagemert
41520MeS

Due ResponsibleAssigned Otce Extension Is ExendedPrionty
521BINGTABing,Ted&AnglBINGTA 1040 Individual IncomeINDIVTAX

41520Miler.Steve
Roers.MelisMICHIGAN

Indvidual Income
Normal

522BROWNU 1040 INDIVTAX Ropers.Meliss MCHIGANNormal
1

Golden Mchal GOLDEN1040 Indvduel IncomeINDIVTAX 415/20Rogers.MelisaRoers.MelissMICHIGAN
1040

Normal
525QUINN QUINN Individual IncomeINDIVTAX4/15/20Rogers.MelisssRogers.MelissMICHIGAN Normal
526SMITHSmith.Tom&KathHNS 1040 Individusl Income

Individua lncome
INDIVTAX4/15/20Tumer,CindyRogers,MeissMICHIGAN Normal

527CRFORDCrawfordsSeak 1040 INDIVTAX41520Turer CindyRogers,MelissMICHIGAN
Adranced Adveris SCopoleTaxR Miller. Steve

Normal

gen
539AAC 1120S BUSINESSTAX9/15/20Miler.Steve MICHIGAN Normal

60 ACEAD

AceAdverising
AceAh ACEAD N AddProject563ACEADVERT ACEADVERTMONTHPAYROMolyPayroll
AceAdvertising PA

PA AddProjecttomulipleClentsNYDH Normal
564ACEADVERT ACEADVERTQTRSALESUSQuarterly Sales&

EstSelected Projects
HIGAN

PA
Normal

565BRON Brown.Jerald&iEROWNJ941 941Employer'sQu HIGAN Nomal
9 BROWNJ IN Dlete SeedPrets HIGAN

BROWN
Normal

571BRONUBroan, BIMEEKPAYRLB-weeoy PayroilP HIGAN Normal
572BRONJBrown. BROANJ BEEKPAYRLD-leekly PayrollPA

Receve SelectedProjects
HIGAN Normal

573CRAFORDCrawford's SleakCRAMFORD941
AC
PA

ChangeTracking
IFORNIA

CRANFORDMARWRITEUPMarchwhiteup
Normel

576CRANFORDCrawford's Steak HIGAN Normal
579CRAFORDCrword'sSteakCRANFORDMONTHPAYROMontly PayrollPA Generate Net Project IFORNIA PN
580CRFORDCrawfordsSkCRFORDQTRSALESUSQuaerly Sales&PA

Print Gnid
IFORNA Normal

581PROTOPrototype DesignPROTO 941 941Emgloyer'sQuPA HIGAN
Preview Routing Sheets for Selected Projects

Normal
ÿ

TasksHetory

Proje560MARiRITEUP-Mrcup
ÿ Order Descrip6onActivity Taget CompleteTrackingStartedComgiend

1 1 PreperebonPREPARATIONTumer.Cindy482014 4/182014 NotSorled

ForHelp,press F1 Curent Login:CATCurrent Period:4/1/2014-430/2014
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4. Press the TAB key. Notice that the Tracking field changes to Started, because 
you have entered an actual start date.   

 
5. Click OK to close the Project dialog.  

Editing multiple projects 
Practice CS also allows you to edit multiple projects at one time. To edit multiple 
projects, select all of the projects that you want to edit from the list, right-click, and 
choose Edit Selected Projects from the context menu. 

Note: To select two or more projects from the list, hold down the SHIFT key and 
click each project with your mouse pointer. For non-consecutive projects in the list, 
hold down the CTRL key and click each project with your mouse pointer. 

In this exercise, you will update multiple projects assigned to staff member Cindy 
Turner. 

1. Click the Assigned column header to sort the list by assigned staff. 

2. Select projects 565 and 573, which are 941 projects for Cindy Turner. Hold 
down the CTRL key to select two non-adjacent projects. 

Project* ÿ X

Main Tasks LinksCustom Fields  Histoy]
Identification Target dates  Actual dates

Number: 560 jeis 4/8/2014 Received:4/8/2014
 Client: Ace Advertising Complete:4/18/2014  Start: 4/8/2014

Project: March Writeup Complete:

Description:March Writeup Due dates
Preparation of Witeup forthe month ofExtension:Not extended

Invoice Description:March.
Current: 4/30/2014 4/30/2014

 Project information Groupings
 Engagement.Accounting Services ÿ Responsible: Rogers, Melissa
Priority: Normal Department:Accounting Department
Tracking:  Started 

 Budget information Assigned

 Base on Tasks Calculate amount automaticallyStaff: Tumer. Cindy
Hours Amount

 Budgeted: 4.00 500.00

Actual: 0.00 0.00

 Est. Remaining: 4.00  Reminder (none) (none)

% Complete: 0° Solution-

Generation  Select solution:Other
 Solution path:Pattern: Due on the last weekday of April

Notes

OK Cancel 
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3. Right-click and choose Edit Selected Projects from the context menu.   

 
4. In the Edit Selected Projects dialog, click the option for the operation you want 

to perform (change project information, add an extension, or add tasks). For this 
walkthrough click Change Project information, then click Next. 

elect the fields that you want to update. From the first drop-down list, select 
Tracking.  

6. From the second drop-down list, select Started.   

 

7. To update additional fields, click the  button to add a new row.   

8. In the second row, select Actual Start Date from the first drop-down list. 

[Practice CS-[Sample5]-{Menge Projects] X

Fie Edit Vew Actons Setup Tools Hep
Add

Manage Projects
ProectsTaska

Open Prects only

ACEADVERT
Client ID

bee lderiting
Client DescripionParent Client

MONTHPAYROMyP
Project Project DescripionEngagemert

430/20RogersMeisaTurerÿCindy
Due ResponsibleAssigned Ofice Exenian Is ExendedPriorty

563 ACEADVERT PAYROLL MICHIGAN
Ace Adverising 4/21/20RogersMelisaTumerÿCindy

Normal
5G4ACEADVERT ACEADVERTQTRSALESUSQuarterlySelesPAYROLL MICHIGAN Normal

BROWNI Bre BROWNU 941 S41Emgioyers QuPAYROLL 43020 MICHIGAN
DROWNU DROWNJ PAYROLL Turer.CindyTurner,CindyMICHIGAN Normal

572BROWNJg BROWN BIMEEKPAYRL PAYROLL41820Tuer.CindyTumer,CindyMICHIGAN Normal
573 CRA Ciawhorde CRAVFORDS41 S1EmployersQu PAYROLL

CRANFORD MarchWhiteup AddProject Nor

on
576CRAFORDCrawfords Seak ACCOUNTI

Add Project to multiple Clients
Normal

579CRANFORDCrewlord'sSeakCRANFORDMONTHPAYROMontly PeyrollPAYROLL
EditSelectedProjects

Noemd
500CRAWFORDCrawford'sSteakCRANFORDQTRSALESUS

Protoype Design
Quarterly Seles&
941Emgloyer'sQuPAYROLL

PAYROLL
Delete Selected Prjects

Normal
581PROTO

ProttypeDesign
PROTO 941 Normal

584PROTO PROTO MONTHPAYROMontly PayrollPAYROLL
Protoype Deign QTRSALESUS Complete Selected Projects Normal

585PROTO
Prottype Deign

PROTO Quarery Sales&PAYROLL
506PROTO QTRWRITEUPQuerlyweiup Receive Selected Projects

Normal

Ace Aderising
PROTO ACCOUNTI

593ACEADVERT Aonlwlhiteup
Normal

ACEADVERTAPRWRITEUP ACCOUNTIChangeTracking Normal
594ACEADVERTAce AdvertisingACEADVERTMAYWRITEUPMayheup ACCOUNTIGenete Net Project

CRANFORD AenlWhteup
Normel

595CRAVFORD
Crawford'sSteek
Crawford'sSheak APRWRITEUP

Mayhtep
ACCOUNTIPintGid Normal

596CRANFORD CRANFORDMAYWRITEUP ACCOUNTI
Preview Routing Sheets for SelectedProjects

Nomgl
598CRANFORDCrawfordsSkCRNFORDMONTHPAYROMonthlyPayrollPAYROLL Normal
599CRAFORDCrawfords SteakCRANFORDMONTHPAYROMoeely PeyrollPAYROLL63020Tumer.CindyTumer,CindyCALIFORNIA Normal

ÿ

TascaHatory
Order Description lasigned Target Start TrackingSanedComglend

ÿ

ForHelp,press F1 Current Login:CATCurrentPeriod4/1/2014-430/2014

Edit Selected Projects

Select the fields you would like to update and enter the values you would like to update them to.

Tracking Started

Selected Projects 2 Projects will be edited

# Client ID Client DescriptionTracking
565 BROWNJ Brown, Jerald & ElizNot Started
573 CRAWFORDCrawford's Steak HoNot Started

<Back Next > Finish Cancel

+
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9. From the second drop-down list, select 4/16 from the calendar. 

10. Add another row and select Actual Received Date and 4/16.   

 
11. Click Finish to close the dialog. 

12. At the prompt, click Yes to confirm.   

 

Edit Selected Projects

Select the fields you would like to update and enter the values you would like to update them to.

Tracking Started

Actual Start Date 4/16/2014

Actual Received Date 4/16/2014

Selected Projects 2 Projects will be edited

# Client ID Client Description Tracking  Actual Start DateActual Received Date
565 BROWNJ Brown, Jerald & Elizabe Not Started
573 CRAWFORDCrawford's Steak Hous Not Started

<Back Next> Finish Cancel

Practice CS X

ÿ You are about to make changes to multiple Projects.
Are you sure you want to continue?

Yes No
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13. In the Manage Projects screen, notice the updates in the Tracking, Received, 
and Started columns of the project list.   

 

Managing projects on the Staff Dashboard 
The Staff Dashboard has three project-related portlets to help manage staff 
workload: Notifications, Projects, and Tasks. 

1. In the toolbar, click the Staff Dashboard button

2. In the Staff Dashboard, click the Projects view. 

3. The Notifications, Projects, and Solutions portlets should be open. For this 
exercise, close the Solutions portlet. 

[Practice CS-[Sample5]-{Menage Projects] X

Ele Edit Yew Actgns Setup Iools Hep
Add

Manage Projects
Tada

ÿ ÿ

OpenProectonly

Project Project DescriptionEngagemertDue Responsiblelasigned Ofice Ensin IsEdendedPrionityTacing
4/30/20RogersMeisaTurerCindy

Received
MONTHPAYROMoyPayrollPAYROLL MICHIGAN Normal

StartedCompletedT
NotStaed

QTRSALESUSQuarterlySales&PAYROLL421/20 RogersÿMelisaTumer.CindyMICHIGAN NomalNot Stared 4152014
MCHGAN

4
541 341EmployersQuPAYROLL 42020 Nor 416/2014

Tumer.Cindy
4/15/2014 4

Bi-WeeklyPayrolPAYROLL44/201Turner.Cindy MICHIGAN NormalNotStaed 4/3/2014
PAYROLL Turer,OindyMICHIGAN 4/15/2014

40
BIWEEKPAYRLBWeeky Payroll 4/18/20Turner,Cindy NormalNot Started 4

P S41EmpoywrsQuPAYROLL 4G020

Turner.Cindy
CAIFORNIA Nor RIOCSIT

ogn
MarchwhiteupACCOUNTING4/3020 Turmer.CindyMICHIGAN NormalNot Stared

412014

MONTHPAYROMonthlyPayrollPAYROUL4/30/20Tumer,CndyTuner.CndyCALIFORNIA NormalNetStarted
QTRSALESUSQuarterly Sales&PAYROLL421/20Turmer,CindyTurer,CindyCALIFORNIA NomalNot Staned4/1B2014
941 941Emgloyer'sQuPAYROLL43020Miler.SheveTumer,CingyMICHIGAN NormalNet Started
MONTHPAYROMonthlyPayrollPAYROLL43020Miler,SteveTurmer,CindyMICHIGAN NormalNot Stared
QTRSALESUSQuarterly Sales&PAYROLL42120Miler,SteveTurer,OindyMICHIGAN Normal Not Started12

QanelyWeneupACCOUNTING43020Miler,SoeveTumer,Cindy
Rogers.MelisssTurner.Cindy

CALIFORNIA Normal NotStared
APRWRITEUPAprilwhiteupACCOUNTING5/30/20 CALIFORNIA NormalN

May VhnteupACCOUNTING6/30/20Rogers.MelsssTumer,CindyCALIFORNIA NormalNot Starled
APRWRITEUPAorlwhteup ACCOUNTING5/30/20Turner.CindyTumer,CindyMICHIGAN Normal Not Stared
MAYWRITEUPMeyVilhteupACCOUNTING02.009

Tune,Cindy
Turer,Cindy

Turner.Cindy
Turert,CindyMICHIGAN Normal

MONTHPAYROMoly Payroll53020 CALIFORA
6/3020Turer.Cindy

Normal Net Stared
MONTHPAYRO|Morthly PayrollPAYROLL Turmer.CindyCALIFORNIA Normal

1

Tasks

Order Description AssignedTget StartTarget CompleteTrackingStartedCompleted

ÿ

For Help,pressF1 Current Login:CATCurrentPeriod4/1/2014-430/2014
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4. You can toggle between the Projects portlet and Notifications portlet — they are 
tabbed into the same viewing area. You have a separate view for the Tasks 
portlet. Drag and resize the portlets to match the following illustration. Because 
the Projects and Notifications portlets are tabbed and sharing space, you will 
have to drag one of the portlet tabs to move it to a new position.   

 
 

Notes  

 or information on how to move and resize portlets, please see the topic 
Resizing and moving portlets in the Practice CS Help & How-To Center.  

 To remove a filter from a portlet, click the Show Options  button in the 

portlet’s title bar, click the show filter  button, and then click the remove 

filter  button. Click the Hide Options  button in the title bar to hide the 
portlet options again.   

 To select the fields that are displayed in the portlet, click the field chooser 

 button. You can also change the order of the columns by dragging and 
dropping.    

[ Practice CS - [Sample5] - [Staff Dashboard]
 sooI dnes suoo ma ti a
Back --eR2Kÿ  Add Search for assistance

Staff Dashboard Wednesday, June 25, 2014
Cindy Turner Add View Select Portlets Select Layout
Overview×Projects ×Tasks× Schedule ×Benefits ×Outlook× Internet ×News &Links x
Notifications

Date/TimeClient ID  Client Description Message
6/25/2014 4:13CRAWFORDCrawford's SteakThe Received Date for Project # 573, 941 Employer's Quarter Fed TR, for Client Crawford's Steak House was ent
6/25/2014 4:13CRAWFORDCrawford's SteakThe Task Preparation on Project # 573. 941 Employer's Quarter Fed TR, for Client Crawford's Steak House is rea

Pane6/25/2014 4:13BROWNJ Brown, Jerald & EliThe Received Date for Project # 565, 941 Employer's Quarter Fed TR, for Client Brown, Jerald & Elizabeth was e
6/25/2014 4:13BROWNJ  Brown, Jerald & Eli 

 uoebian 
1/24/2014 4:48 A Phone Message from Collins, Tom was taken for you by Wilson, Jeff.
1/23/2014 9:10CRAWFORDCrawford's SteakClient CRAWFORD has exceeded their $10.000.00 A/R limit by $2.624.70.
11/18/2013 11: A Scheduled Benefit request was entered by Cross. Candace for 40.00 hours starting on 6/23/2014 12:00 AM an
11/18/2013 11: A Scheduled Benefit request was entered by Cross, Candace for 40.00 hours starting on 5/5/2014 12:00 AM and

Projects =ÿ

 Drag a column header here to group by that column.
# Client ID  Client Description Parent Client Project  Project DescriptionEngagement ResponsibleAssigned Office

1 492 WILSON Wilson, Dan & JoaWILSON 1040SIMPLEIndividual Income TINDIVTAX Turner, CindyRogers, MelissaMICHIGAN 
512 ANIMAL  Animal Shelter 101 ANIMAL 1041 Estate and Trust TaBUSINESSTAXTurner. CindyMiller, SteveMICHIGAN 
526 SMITH Smith, Tom & KathSMITH 1040 Individual Income TINDIVTAX Turner, CindyRogers, MelissaMICHIGAN
527 CRAWFORDCrawford's SteakCRAWFORD 1040 Individual Income TINDIVTAX Turner, Cindy Rogers, MelissaMICHIGAN 
560 ACEADVERTAce AdvertisingACEADVERTMARWRITEUPMarch WriteupACCOUNTINGRogers, MelissaTurner, CindyCALIFORNIA
563 ACEADVERT Ace AdvertisingACEADVERTMONTHPAYROLMonthly PayrollPAYROLL Rogers, MelissaTurner, CindyMICHIGAN 
564 ACEADVERTAce AdvertisingACEADVERTQTRSALESUSEQuarterly Sales & UPAYROLL Rogers, MelissaTurner. CindyMICHIGAN 
565 BROWNJ Brown, Jerald & EliBROWNJ 941 941 Employer's QuaPAYROLLMiller, SteveTurner, CindyMICHIGAN 
571 BROWNJ Brown, Jerald & EliBROWNJ BIWEEKPAYRLBi-Weekly PayrollPAYROLL Turner, CindyTurner, CindyMICHIGAN
572 BROWNJ Brown, Jerald & EliBROWNJ BIWEEKPAYRL Bi-Weekly PayrollPAYROLL Turner, Cindy Turner, CindyMICHIGAN 
573 CRAWFORDCrawford's SteakCRAWFORD941 941 Employer's QuaPAYROLL Turner, CindyTurner, CindyCALIFORNIA

For Help. press F1 Current Login: CAT  Current Period: 4/1/2014 - 4/30/2014

 F 
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Projects portlet 
The Projects portlet gives you access to several project management features from 
one place. This portlet lists all projects for which the currently logged in user (in this 
case, Cindy Turner) is the Assigned or Responsible staff member. In the Projects 
portlet you can:  

 Click a column header to sort the list of projects by that column 

 Double-click any project to open it 

 Click a solution icon, if the project has a solution set up, and launch that 
solution to work on the project. For example, if you are licensed for 
UltraTax CS, you can click the  icon to start the program. If you marked the 
Start Timer for Projects checkbox in User Preferences, launching the solution 
from the project will also start a timer in Practice CS.   

You can also click the Projects portlet title bar to open the Manage Projects screen.    

 

To return to the Staff Dashboard from the Manage Projects screen, click the Back 
button on the toolbar.   

 

1. Double-click project 580 in the Projects portlet to open it.  

2. In the Due dates section of the Project dialog, change the due date in the 
Current field to 4/30 and press TAB.  

Projects

Drag a column header here to group by that column

Client ID Client Description Parent Client

492 WILSON wilson,Dan &Joa WILSON

512 ANIMAL Animal Shelter 101 ANIMAL

526 SMITH Smith,Tom&Kath SMITH

527 CRAWFORD Crawford's Steak CRAIWFORD

560 ACEADVERT AceAdvertising ACEADVERT

Practice CS - [Sample] - [Manage Projects]
File  Edit  View  Actions  Setup  Tools  Help

Back PPH

ManageProjects
ProjectsProject Tasks

Search

Filter

Drag a column header here to group by that column

# Client ID Client DescriptionParent Client

594 HANNA Hanna,Jason HANNA
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3. If prompted to update the target dates and extensions, click No, Just change 
the original Due Date.   

 
4. If prompted to update the project recurrence pattern, click No, I do not want to 

change the recurrence pattern.   

 
5. Click OK.    

 

Project* ÿ X

Main Tasks Links Custom FieldsHistory
Identification Target dates Actual dates 
Number: 580 yeis 4/18/2014 Received:4/18/2014
 Client:  Crawford's Steak House Complete:4/23/2014 :1eis (none)
Project: Quarterly Sales & Use Tax Complete:(none)

Description:Quarterly Sales & Use TaxDue dates
Preparation of Quatenty Sales &Use TaxExtension:Not extendedInvoice Description:Retum forthe peniod ended [Date Fomat
(Month End Date(Report Date, -2). Current: 4/30/2014ÿ ÿ

Groupings
 Engagement. Payroll Services Responsible:Tumer, Cindy 
Priority: Normal Department:Accounting Department
Tracking:  Paeis 1n 

Assigned

 Base on Tasks Calculate amount automaticallyStaff:Tumer. Cindy

Hours Amount
 Budgeted: 2.50 125.00

Actual: 0.00 0.00

 Est. Remaining: 2.50  Reminder (none) (none)

% Complete: 0%ÿ Solution
Generation  Select solution:Other

 Solution path:Pattern:Due on day 20 of frst month in quarter

Notes

OK Cancel 
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6. Notice the Desktop Notification that appears at the bottom of your screen.  

 
This message appears because you enabled desktop notifications in the 
System tab of the User Preferences dialog. See “User preferences,” which 
begins on page 21, for details.  

Notifications portlet 
The Notifications portlet provides a listing of any notifications sent to the staff 
member.  

 Click the Refresh  button on the toolbar, and notice the new message that 
appears in the Notifications portlet. This message was generated because you 
changed the due date on the project for which you were the Responsible staff 
member. We set up the notification earlier in the Notifications section of this 
walkthrough.   

 
 

Notes  

 Desktop notifications will appear within 60 seconds after a notification is sent. 

 Notifications remain in this portlet until cleared. To clear notifications from the 
portlet after you have read them, right-click and choose Clear Selected 
Notifications from the context menu.   

 

Notifications

Date/Time Client ID Client Description Message
6/25/20144:22 CRAWFORD CrawfordsSteak The Due Date for Project #580.Quarterly Sales & Use Tax,for Client Crawford’s Steak House Was changed f
6/25/20144:13 CRAIWFORD Crawford'sSteak The Received Date forProject #573.941Employer's Quarter Fed TR,for Client Crawford’s Steak House was
6/25/20144:13 CRAWFORD Crawford's Steak The Task Preparation on Project #573,941 Employer's Quarter Fed TR, for Client Crawford’s Steak House is

6/25/20144:13 BROIWNJ Brown,Jerald&Eli The Received Date for Project #565. 941 Employer's Quarter Fed TR, for Client Brown,Jerald & Elizabeth wa
6/25/20144:13 BROWNU Brown,Jerald&Eli

A Phone Message from Collins, Tom was taken for you by Iwilson, Jeff.

Notifications

Date/Time V Client ID Client Description Message
6/25/2014 4:22CRAWFORD Crawford's Steak latefnrPrniertt58n Ouarterlu Sales & Use Tax, for Client Crawford's Steak House was changed f

6/25/2014 4:13CRAWFORD Crawford's Steak Select All yer's Quarter Fed TR, for Client Crawford's Steak House was
6/25/2014 4:13CRAWFORD Crawford's Steak Deselect All Dloyer's Quarter Fed TR, for Client Crawford’s Steak House is
6/25/2014 4:13 BROWNJ Brown, Jerald & Eli Clear Selected Notifications yer's Quarter Fed TR. for Client Brown. Jerald &Elizabeth wa
6/25/2014 4:13BROWNJ Brown, Jerald & Eli Show Options oloyer's Quarter Fed TR,for Client Brown,Jerald & Elizabethi

1/24/2014 4:48
Print Grid...

for you by wilson, Jeff.

Select Portlets...

Add View...
Edit View...
Delete View...

Select Layout...
Save Layout As...

Delete Layout...
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Tasks portlet 
The Tasks portlet lists all of the tasks assigned to the current staff member. As with 
the Projects portlet, you can sort the task list by column headers, double-click any 
task to open it, and launch a solution by clicking the solution icon.  

1. Click the Tasks view on the Staff Dashboard. 

ouble-click task 1 for the 1040EX project.   

 
3. For this exercise, do not make any changes to the task. Click OK to close the 

Tasks dialog and return to the dashboard.   

 

Tasks

Drag a column header here to group by that column

Project Project Description Client ID Client Description Parent Client Order Description Ready Activity Assigned
BIlWEEKPAYRL Bi-lweekly Payroll BROIWNJ Brown. Jerald & Eli BROWNJ Preparation PREPARATION Turner, Cindy MICH

BIlWEEKPAYRL Bi-Weekly PayrollBROWNJ Brown,Jerald &Eli BROWNJ 1 Preparation PREPARATION Turner.Cindy MICH

QTRSALESUSE Quarterly Sales & U CRAIWFORD Crawford's Steak CRAIWFORD Preparation PREPARATION Turner, Cindy CALIF

QTRSALESUSE QuarterlySales& U ACEADVERT Ace Advertising ACEADVERT 1 Preparation PREPARATION Turner.Cindy MICH

QTRSALESUSE Quarterly Sales & U PROTO Prototype DesignPROTO 1 Preparation PREPARATION Turner, Cindy MICH

1040EX 1040TaxReturnEx HANNA Hanna.Jason HANNA Client Meetings & CLIENTMEET Turner. Cindy MICH

1040EX 1040 TaxReturn ExHANNA Hanna.Jason HANNA 3 Review REVIEW Turner, Cindy MICH

LinksCustom FieldsHistory
Identification Target dates Actual dates

Order: Start: 12/31/2014 eis

Activity: Client Meetings & Discussions Complete:3/31/2015 Complete:(none)

Description:Client Meetings & Discussions

Task information Assigned
Client: Hanna. Jason Staff:Tumer. Cindy

Project: 1040 Tax Return Example

Tracking: Not Started

Budget information

Calculate amount automatically ÿ Reminder(none) (none)

Hours Amount Solution

Budgeted: 0.50 $112.50 Select solution:2013 UItraTax CS
Actual: 0.00 $0.00 Completion event:Client Meeting Complete
Est. Remaining: 0.50

Notes

Edit Project.. OK Cancel

2. D
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Managing projects on the Client Dashboard 
When you want to view all of the current projects and associated tasks for a 
selected client, use the Client Dashboard. 

1. Click the Client Dashboard button on the toolbar.   

2. From the drop-down list at the top of the screen, select client HANNA (Jason 
Hanna). 

3. Click the Projects view. 

4. In the Projects portlet, click the Show Options button, mark the Show Tasks 
checkbox, and then click the Hide Options  button.   

5. Select the 1040EX project. 

From the Projects portlet, you can view or modify any project or task information 
by double-clicking it.   

 

Projects X

Drag a column header here to group by that column.

# Client ID Client Description Parent Client Project Project Description Engagement Responsible Assigned
490 HANNA Hanna, Jason HANNA 1040SIMPLE Individual Income T INDIVTAX Rogers, Melissa Rogers, Melissa

592 HANNA Hanna, Jason HANNA 1040NOTICE Individual Tax Notic INDIVTAX Rogers, MelissaRogers, Melissa
613 HANNA Hanna. Jason HANNA 1040EX 1040 Tax Return Ex INDIVTAX Rogers. Melissa

III

Tasks

Project 613.1040EX-1040 Tax Return Example

ÿ Order Description Activity Assigned Target Start Target Complete Tracking Started Completed
Client Meetings & CLIENTMEET Turner. Cindy 12/31/2014 3/31/2015 Not Started

2 Preparation PREPARATION wilson, Jeff 12/31/2014 3/31/2015 Not Started

3 Review REVIEW Turner. Cindy 3/31/2015 3/31/2015 Not Started
4 Assembly ASSEMBLY Rogers, Melissa3/31/2015 3/31/2015 Not Started
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Associating projects with time entry 
While you are entering time for a transaction that has a project set up, you can 
associate the project with the time entry. In this section, you will enter time for a 
project, and update project and task information during time entry. 

1. Open the Time & Expense Entry screen (Actions > Time & Expense Entry). 

2. In the Sheet date field, enter 4/10. 

3. In the first row of the Time subtab, select client HANNA in the Client field and 
INDIVTAX in the Engagement field. 

4. In the Project field, click the down arrow  button and select the 1040EX 
project from the drop-down list.     
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5. In the Task field, click the down arrow  button and select task #1.   

 
6. Right-click the Task field and choose Complete Task1 from the context menu.   

 

ÿ

Practice CS - [Sample5] - [Time & Expense Entry] ÿ x

File Edit View Actions Setup Tools Help
Back--2#Mÿ-#ÿ - PP DI  Search for assistance

Time & Expense Entry
EntryOverview Integrated Entries
Staff: Turner. Cindy  Sheet date:4/10/2014 Journal 

Time Expense
Client  Engagement Project Activity Date  Rate Hours  Amount Comment  Biller Note 

ÿ HANNA INDIVTAX1040EX 4/10/2014 0.00
ÿ  Open Tasks only

Pane 
0

ÿ  Order Task DescriptionActivity ReadyTracking Started  Completed Target Start Target Comple Assigned 
Tasks Assigned to CAT (Tumer, Cindy)

Client Meetings & Disc CLIENTMEETNot Started 12/31/20143/31/2015Turner, Cindy
3 Review  REVIEW  Not Started 3/31/20153/31/2015 Turner, Cindy 

Tasks Not Assigned to CAT (Tumer. Cindy)
Assembly ASSEMBLY Not Started 3/31/20153/31/2015 Rogers, Melis
 Preparation PREPARATIO  Not Started 12/31/2014 3/31/2015 Wilson, Jeff 

 Entry Information  Time Recap Links | Custom Fields History
Entry Information Timer Information 

Client: Hanna Jason Date  Start TimeEnd Time  Elapsed Time  Accumulated Time
 Engagement:
Project: 1040 Tax Return Example
Activity.

For Help. press F1 Current Login: CAT Current Period: 4/1/2014 - 4/30/2014

 Practice CS - [Sample5] - [Time & Expense Entry] ÿ x
File Edit View Actions Setup Tools Help
GBack -. eÿ2Kÿu- # [ Add Search for assistance?

Time & Expense Entry
EntryOverviewIntegrated Entries
 Staff:Turner, Cindy  Sheet date:4/10/2014 Journal 

Time Expense
Client  Engagement Project  Rate Hours? Amount Biller Note

ÿ HANNA 1040EX ? Discussior -ICLENTMEFT 4/10/2014LIndividual Tal0. 0.00
ÿ Complete Task1 #

0 0 Change Tracking [00:0 0.00

 Pane Add Task

Navigation I
Edit Task 
Delete Task
Print Grid
Spell Check
Edit Selected Time & Expense Entries
Delete Entry

 Entry Information  Time Recap Links Custom Fields History
 Entry Information Timer Information 

Client: Hanna, Jason  Date  Start TimeEnd TimeElapsed Time Accumulated Time

 Engagement:Individual Tax Services
Project:  1040 Tax Return Example

 Activity:  Client Meetings & Discussions

For Help. press F1 Current Login: CAT Current Period: 4/1/2014 - 4/30/2014 
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7. Right-click the Task field again and choose Edit Task from the context menu. In 
the Task dialog, notice that the Tracking field and Actual dates section have 
been updated.   

 

Note: You can also use this context menu to change the tracking status of a 
task, or to add or delete a task. 

8. Click OK to close the Task dialog. 

9. In the Hours field, enter 1.5. 

10. Press ENTER to complete the entry. 

 

Taskinformation

Client: Hanna,Jason

Project: 1040TaxReturnExample

Tracking: Completed
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Analyzing Projects 
Practice CS offers a variety of ways to analyze your clients’ projects and monitor 
staff workload.  

Calendars 
Practice CS includes staff, client, and firm calendars. In these calendars, you can 
view projects, tasks, Outlook tasks, and Outlook appointments on screen in a 
familiar calendar format. Under Displayed Items, mark the checkboxes for the 
content you want to view, such as projects, tasks, Outlook tasks, and/or Outlook 
appointments. You can also choose whether to view the calendar in a single-day, 
five-day work week, seven-day week, monthly, or timeline format.   

 

 

Dates in boldface 
indicate when 
something is 
listed for that 
day. 

Projects and tasks are displayed 
on their target start dates, unless 
those dates have already passed. 
If the project or task does not 
have a target start date, 
Practice CS will use the Project 
Due Date as the date for 
displaying the project or task. 
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Client Calendar 
The Client Calendar shows items for the selected client. In this exercise, you will 
view the calendar for client HANNA. 

1. From the View menu, choose Client Calendar. 

2. Select client HANNA (Hanna, Jason) from the drop-down list in the upper left 
corner. 

3. Verify that the Projects and Tasks checkboxes are marked under Displayed 
Items. 

4. In the mini calendar in the left frame, navigate to the current month and click 
today’s date. 

5. Click the Month button in the toolbar for the monthly calendar format. Note the 
projects and tasks on the calendar.  

6. Double-click the first item shown on the calendar. Double-clicking a project or 
task in the calendar opens the related dialog.   

 

Projects and tasks are 
displayed on their target 
start dates, unless those 
dates have already 
passed. If the project or 
task does not have a target 
start date, Practice CS will 
use the Project Due Date 
as the date for displaying 
the project or task. 
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7. Review the information, and then click OK.   

 

Staff Calendar 
The Staff Calendar shows Practice CS projects and tasks, as well as Outlook 
appointments and tasks. 

1. Choose View > Staff Calendar. 

2. Under Displayed Items, verify that only the Projects and Tasks checkboxes are 
marked.  

3. Click the Select Staff button at the top of the screen. 

4. Select staff MHR and then click the Select button so both CAT and MHR are 
selected. 

5. Click OK.    

 
Now the staff calendars for both Cindy Turner and Melissa Rogers are open. 

Main Links Custom FieldsHistory
Identification Target dates Actual dates

Order: 2 Start. 4/8/2014 (none)
Activity: Review Complete:4/10/2014 Complete:(none)

Description:Review
Task information  Assigned
Client: Hanna, Jason Staff:Roqers, Melissa

Project: Individual Income Tax Return 

Tracking: Not Started

Budget information

Calculate amount automatically ÿ Reminder(none) (none)

Hours Amount Solution 

Budgeted: 0.25 $56.25 Select solution:2013 UItraTax CS
Actual: 0.00 $0.00 Completion event:Review Complete
Est. Remaining: 0.25

Notes

Edit Project.. QK Cancel

Select Staff.*

Search
ID Description ID Description

JPW Wilson, Jeff CAT Turner, Cindy
SAM Miller, Steve MHR  Rogers, Melissa

<p1

Select All >>

<Remove

<< Remoye All

OK Cancel
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6. Notice the tasks and projects scheduled for Melissa Rogers on today’s date.   

 
7. Double-click any item in the calendar to view or change the item.  

lick OK.   

 
 

 

[Practice C5-[Sample4]-[Staff Calendar]
d

Add. TodayDay Work WeekWeek Month Timeline
Staff Calendar March30-May03
CalendarOptions Select St

SMTWTFS
April 2014 Turner,Cindy Rogers,Melissa

30311234 Mon Tue isled Thu Fri Tu Thu FiE
6789101112 Mar3031 Apr1 2 3 4 5 Mar3031 Apr1 3 4
13141516171819

5

20212223242526

0y-0cW Mar30-Aor052728293012
45678910

Displayed tems 6 10 11 12 OL 11 12

OulkAapointents

er06-Ar12 Aer06-Apr12OuookTasks
Prects
Tasks

13 14 15 16 17 18 19 13
1041:

14 15 16 17 18 19

-
1040 QTRS QIRS

-
1040 1041: QTRS

1065: 1040 QTRS QTRS 1040 1041:
1065: BIWE 1040 1041:
1065: BIWE 1040

1041
1041:

1065 1040

02 21 22 23 24 25 26 20 21 22 23 24 92

-
QTRS
QTRS

27 28 29 30 May12 E 27 8Z 29 OE May1
MONT MONT10405
MONT QTRC
941:5 941:5
941:P 941:P
941:5

Fox Help,pessF1 Current LoginCATCure Peiod:4/1/2014-4/30/2014

LinksCustom FieldsHistory
Identification Target dates Actual dates

Order: Start: 5/1/2014 eis

Activity: Preparation Complete:9/30/2014 Complete:(none)

Description: Preparation

Task information Assigned
Client:  Bing. Sally Staff:Roqers, Melissa

Project: Individual Income Tax Return

Tracking: Started

Budget information

Calculate amount automatically ÿ Reminder(none) (none)

Hours Amount Solution

Budgeted: 2.00 $450.00 Select solution:2013 UItraTax CS
Actual: 0.50 $112.50 Completion event:Preparation Complete
Est. Remaining: 1.50

Notes

Edit Project.. OK Cancel

8. C
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Standard reports 
The Practice CS Project Management module provides a set of project 
management reports for analyzing your firm’s projects and tasks.  

List of Project Templates 
This report is designed to help your firm review all of the project templates that have 
been set up and verify that the information they contain is accurate. If you need to 
make corrections to a template, you can click any field in the report preview and use 
the program’s drill-down capability to edit the information in the Project Templates 
screen.  

1. Choose File > Print Reports. 

2. In the Print Reports screen, scroll down to the Project Management reports. 

lick List of Project Templates, and then click the Select button. 

4. Click the Preview Selected button.   

 

3. C  
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5. In the report preview, click 1040 Tax Return Example.   

 
6. The Project Templates screen opens with the 1040EX project selected. Here 

you can update the template by clicking the Edit button and changing the 
necessary information. For this exercise, do not change the template.   

 
7. Click the Back button on the toolbar to return to the report preview. 

8. Click the Back button on the toolbar to return to the Print Reports screen.  

 Practice CS - [Sample5] - [Project Templates] ÿ -x-

GBack--2##ÿ#-# ÿ - Pp | Search for assistance

Project Templates
Search: Main Tasks LinksCustom Fields

ID Description Identification
90L Estate Tax ReturnID: 1040EX 
709 Gift Tax Return

Description:941 941 Employer's Quarter F 1040 Tax Return Example

990 Not For Profit Tax Return US Individual Income Tax Retum
Invoice description:

1040 Individual Income Tax Re
1040ES 1040 Estimated Tax PayProject information Groupings
1040EX  1040 Tax Return Exampl Engagement:Individual Tax Services Responsible:1040 Extension  Client Partner

Pane1040EXT
1040NOTICIndividual Tax Notice Priority:  Normal ÿ  Department:  Responsible Staff Department
1040SIMPLIndividual Income Tax ReTracking:  Not Started ÿ
1040TAXPLIndividual Tax PlanningEntities-
1040X Amended Individual Inco

Associated Entities:Individual Entity1041 Estate and Trust Tax Ret
1065 Partnership Tax ReturnBudget information Assigned-
1099 1099  Base on Tasks  Client Manager
1120  Corporate Tax Return Calculate amount automatically
1120S  S Corporate Tax Return

1120 Estimated Tax PayHours: 0.01120w
ACCTSYSCAccounting System ConfiAmount: s
ANNSALESAnnual Sales & Use TaxGeneration Solution-
ANNUALCOAnnual Compilation

 April Writeup Select solution: UltraTax CS APRWRITE
AUDIT  pny Pattern:Due on every April 15  Completion event:
AUDIT2 Audit2 Extension event: Return Extension Filed
AUGWRITEAugust Writeup
BIWEEKPA Bi-lWeekly Payroll Extensions

Business Amended Tax Extend the original due date by:BUSAMEND

BUSTAXEXBusiness Tax Extension Extension Number Month(s) Day(s)
BUSTAXNOBusiness Tax Notice

6

RIISTAXPIRusiness Tay Planninn
PPV ip3  Delete Import Default Project Templates Ja03 Cancel 

For Help. press F1 Current Login: CAT Current Period: 4/1/2014 - 4/30/2014 
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9. Click the Remove button to remove the List of Project Templates from the 
Selected Reports pane. 

Project Budget to Actual 
The Project Budget to Actual report shows variances between budgeted and actual 
hours and amounts per project. You can use the Report Options to group and filter 
the report in a variety of ways. In this exercise, you will preview the report based on 
the target complete dates, grouped by client. 

1. Click the Project Budget to Actual report in the list. 

2. Click the Select button. 

3. In the Selection tab, select Project Target Complete in the Based on field.   

 
4. Click the Layout tab. 

Report Options
Description: Project Budget to Actual

Description override:

SelectionLayout

Dates

Report date:Period End Date 4/30/2014

Detail line:Period-to-date 4/1/2014 to 4/30/2014

Based on:Project Target Complete

Filtering

Filter

Filter

Filter
Filter ÿ

Filter
Filter

III
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5. In the top Group by field, select Client from the drop-down list.   

 
6. Click the Preview Selected button. 

7. Review the data on the report.   

 

Report Options
Description: Project Budget to Actual

Description override:

SelectionLayout

uoyos Direction:
Group by: Client ID Ascending

(None) Ascending
(None) Ascending

Detail by:. Project Number  Ascending

ÿ Print Cover Sheet

III
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Notes 

 To view page two of the report, click the Next Page  button on the 
toolbar. 

 To scroll through a multi-page report, click the Continuous Scroll  button 
on the toolbar.   

8. Click the Back button on the toolbar. 

9. Click the Remove button to remove the report from the Selected Reports pane. 

Project Listing 
The Project Listing report provides a list of all projects that have been entered into 
Practice CS. If you mark the Include Task Detail checkbox on the Layout tab, the 
report also lists the tasks associated with each project. This report provides project 
information such as target start date, current due date, project budgeted amounts, 
and task details, and it can be grouped in many different ways, depending on the 
information that you need. In this exercise, you will preview a list of projects with a 
due date in the current period, grouped by responsible staff and by client.  

1. In the list of reports, click the Project Listing report. 

lick the Select button. 

3. In the Selection tab, verify the following selections. 

Field Selection 
Report date End Date 

Detail line to-date 

Based on Project Current Due Date 
 

4. Click the Layout tab. 

5. In the Group by field, select Project Responsible in the first row and Client in the 
second row. 

2. C

 Period 

 Period-
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6. Verify that the Include Task Detail checkbox is marked.   

 
7. Click Preview Selected.   

 
8. Click the Back button on the toolbar to return to the Print Reports screen. 

9. Click the Remove button to remove the Project Listing report from the Selected 
Reports pane. 

 Report Options 
Description: Project Listing
Description override:

SelectionLayout

Sort on: Direction: Page
Breaks:

Group by: Project ResponsiblID Ascending ÿ

Client ID ÿ Ascending ÿ

(None) Ascending

Detail by: Project Number Ascending

Print Cover Sheet

Include Task Detail

Parnes, Velano, Martinez & Co.

Project Listing
April 1, 2014 - April 30, 2014

Date Based on: Project Current Due Date

Budget p5png
ID  Desciption Client Name  Responsible AssignedPrionty Hours Amount2e15 Due Date

CAT

AnimalShelter 101

512 Estate and TrustTax Return Animal Shelter101 CAT SAM Normal 7.00 1,812.50  04/15/14
Task Detail: Order  Activity Assigned 1e15 161 sInoH Pa Bdgt Amount Trgt Complete 

1 ASSIGNBUDSAM 0.50 137.50
2 PREPARATIONSAM 1.50 412.50
3 REVIEW MHR 1.50 375.00
4 CLEARREVEWMHR 1.50 375.00
5 FINALREVEWMHR 1.50 375.00
6 CLIENTCOPYSAM 0.50 137.50
7 ELFAUTHORZMHR 0.00 0.00
8 ELFASSEMBLYMHR 00'0 0.00
6 ELFTRANSMITMHR 0.00 0.00

7.00 1,812.50

Animal Shelter 101 Totals 7.00 1,812.50

BROWNJ Brown, Jerald & Elizabeth

571 Bi-Weekly Payroll Brown, Jerald &ElizabethCAT CAT Normal 3.00 0.00 04/03/14 04/04/14
TaskDetal: OrderActivity Assigned Trgt Start  sInoH Pa Bdgt Amount Trgt Complete

PREPARATIONCAT t1/20/t0 3.00 0.00 tt/t0/t0
3.00 0.00

572 Bi-Weekly Payroll Brown, Jerald &ElizabethCAT CAT Normal 3.00 00'0 04/16/1404/18/14
TaskDetail OrderActivity Assigned 1215 1611snoH 16p8BdgtAmount Trgt Complete

1 PREPARATIONCAT 04/16/14 3.00 0.00  04/17/14
3.00 0.00

Printed by CATon4/15/2014 at 10:50 AM Page l
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Project Tracking 
Use the Project Tracking report to track the status of projects in Practice CS. This 
report lists staff involved with the project and important dates, such as target 
start/complete, actual start/complete, received, and due dates, and the number of 
times the project has been extended. This information allows you to see which 
projects are near completion and which ones are at risk of falling behind.  

1. Select the Project Tracking report. 

2. On the Selection tab, select Project Current Due Date in the Based on field. 

3. Click the Layout tab. 

4. In the Group by field, select Project Tracking in the first row. Verify that (None) 
is selected for the second and third rows. 

5. Click the Preview Selected button.   

 
6. Click the Back button on the toolbar to exit the preview screen. 

7. Click the Remove button to remove the Project Tracking report from the 
Selected Reports pane. 

Routing Sheet 
The Routing Sheet report provides your firm with a hardcopy routing sheet that 
shows the details of a project and the status of any associated tasks. The report, 
which can be routed from person to person in the office, indicates which tasks need 
to be signed off before subsequent tasks can begin.  

1. Select the Routing Sheet report. 

2. In the Selection tab, select Year-to-date in the Detail line field. 

elect Project Actual Complete in the Based on field. 3. S  
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4. Click the Preview Selected button.   

 
5. Click the Back button on the toolbar. 

6. Click the Remove button to remove the Routing Sheet report from the Selected 
Reports pane. 

Note: You can also print the Routing Sheet for selected projects from the Manage 
Projects screen. Right-click and choose Print Routing Sheets for Selected from the 
context menu. 

Task Budget to Actual 
The Task Budget to Actual report shows variances between budgeted and actual 
hours and amounts per task. In this exercise, you will preview the report based on 
the target complete dates, grouped by client. 

Parnes, Velano, Martinez & Co.

Routing Sheet
January 1, 2014 - April 30, 2014

Date Based on: Project Actual Complete

Projed Client Dates
ID 432 ID AAC Targ et Start 09/30/13
Projet Advanced Advertising ConsultanTarget Complete 02/28/14
Description  Contact Name 10/22/13
Department Attestation Department  Primary Phone (215) 658-9588
 Responsible SAM Partner SAM Actual Start 09/30/13
Assigned  JPW offce MICHIGAN Actual Complete02/28/14
Priority Normal  Engagement.
Tracking Completed ID Audit Services Original Due Date03/31/14

Biller Current DueDate03/31/14
Reviewer

Project Notes

p6png Target Actual
 Order Activty Assigned Tracking1e15 snoHCompleteStart CompleteInitials 

1 Assign &Budget  Miller, Steve Completed 09/30/13 5.00 10/08/1309/30/13 09/30/13
5 Engagement Letter Miller, Steve Completed 10/09/13 4.00 10/10/1310/09/13 10/09/13
5 Pre-Analytical Prodeaures Miller, Steve Completed 10/14/13 5.00 01/10/1410/16/13 10/16/13
5 Risk Assessment/Control Miller, Steve Completed 10/14/13 4.00 01/10/144 10/16/13 10/17/13
5  Minutes  Miller, Steve Completed 10/14/135.00 01/10/14 10/16/13 10/17/13
10 Cash  Miller, Steve Completed 01/11/14 5.00 02/08/14 01/13/14 01/15/14
10 Accounts Receivable Miller, Steve Completed 01/11/14 4.00 02/08/14 01/13/14 01/15/14
10 Inventory  Miller, Steve Completed 01/11/14 7.00 02/08/14 01/13/14 01/17/14
10 Prepaids & Other Current Asset Miller, SteveCompleted 01/11/14 4.00 02/08/14 01/14/14 01/14/14
10 Property, Equipment, and Lease Miller, Steve Completed 01/11/14 7.00 02/08/14 01/13/14 01/21/14
10 Notes Payable  Miller, Steve Completed 01/11/14 4.00 02/08/14 01/13/14 01/21/14
10 Accounts Payable  Miller, Steve Completed 01/11/14 4.00 02/08/14 01/14/14 01/22/14
10 Other Current Liabiites  Miller, Steve Completed 01/11/145.00 02/08/14 01/14/13 01/21/14
10 Equity  Miller, Steve Completed 01/11/14 4.00 tT/Tz/T0 t1/ST/T0 t1/80/z0
10 Income Taxes  Miller, Steve Completed 01/11/14 6.00 02/08/14 01/16/14 01/22/14
10 Revenues  Miller, Steve Completed 01/11/14 00 02/08/14 01/16/14 01/22/14
10 General, Admin, & Selling Bp Miller, Steve Completed 01/11/14 4.00 02/08/1401/17/14 01/22/14
10  Other Income and Expenses Miller, Steve Completed 01/11/14 4.00 02/08/14tT/0z/T0 tT/0z/T0
15 Finanical & TaxDeferred Calcs Miller, Steve Completed 02/09/14 5.00 02/10/1402/09/14 02/09/14
20 Analytical Procedures Miller, Steve Completed 02/11/14 4.00 02/12/14tT/TT/20 +T/T1/20
25 Workpaper Review  Millr, Steve Completed 02/13/1410.0002/14/1402/11/14 02/12/14
30 Financial Statement Prep Miller, Steve Completed 02/15/148.00 02/17/1402/13/14 02/13/14
35 Financial Statement ReviewWilson, Jff Completed 02/18/146.00 02/20/1402/18/14 02/18/14

 Management Rep Letter Miller, Steve Completed 02/21/14 02/23/1402/22/14 02/22/14
45 Assembly Rogers, Melissa Completed 02/24/14 6.00 02/25/1402/25/14 02/25/14
50 Delivery Rogers, Melissa Completed 02/26/143.00 02/27/1402/26/14 02/26/14
55 Wrap Up Meeting Miller, Steve Completed 02/28/14 4.00 02/28/1402/28/14 02/28/14

Project Totals 137.00

Printed by CATon4/15/2014 at 10:54 AM Page l
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1. Double-click the Task Budget to Actual report. 

2. In the Selection tab, select Task Target Complete in the Based on field.  

3. Click the Layout tab. 

4. In the Group by field, select Client.  

5. Click the Preview Selected button. 

6. Review the data on the report.   

 

7. Click the Back button on the toolbar. 

8. Click the Remove button to remove the Task Budget to Actual report from the 
Selected Reports pane. 

Task Tracking 
The Task Tracking report provides information such as which staff are assigned to 
projects and which tasks are ready to be started. Staff can use this report when they 
need to know if they can begin a task and whether the preceding tasks have been 
completed. 

1. Double-click the Task Tracking report. 

2. In the Selection tab, select Custom Date Range in the Detail line field.  

3. For the date range, enter 1/1/2014 to 4/30/2014. 

Parnes, Velano, Martinez & Co.

Task Budget to Actual
April 1, 2014 - April 30, 2014

Date Based on: Task Target Complete

Projedt Hours Amount -.. TargetClient Name
Actual

ID  Number Project Desciption  Assigned Activty p6png  Actual Variance Budget Actual VarianceComplete Complete

ABCP ABCPartnership

ABCP ABC Partnership509 Partnership TaxRetum CATReview 2.50 0.00 2.50 625.00 0.00 625.00 04/08/14
509 Partnership TaxRetumCCAT  Final Review 1.50 0.00 1.50 375.00 0.00 375.0004/11/14
509  Partnership TaxRetumMHR  Preparation 6.00 0.00 6.00 1,500.00 0.00 1,500.00t1//0/t0
509 Partnership Tax Retum1MHR Clear Review Comments000 0.00 3.00 750.00 00'0 750.0004/10/14
509  Partnership TaxRetumMHR  Client Copy Padkaging0.25 0.00 0.25 62.50 0.00 62.50 t1/t1/t0
509  Partnership TaxRetumMHR  E-File Authonzation0.00 0.00 0.00 0.00 0.00 0.00 04/14/14

Received
509  Partnership Tax RetumMHR  E-File Assembly 0.00 0.00 0.00 0.00 0.00 0.0004/14/14
509 Partnership TaxRetum MHR E-File Transmitted 00'0 0.00 00'0 00'0 00'0 00'0 04/14/14

ABC Partnership TotalsTask count = 8 13.25 00'0 13.25 3,312.50 0.00 3,312.50

ACEADVERTAce Advertising
ACEADVE Ace Advertising Consultants 560March WriteupCAT Preparation 00 0.00 00 00'005 00'0 500.0004/18/14
RT

564 Quarterly Sales &UseCAT  Preparation 2.50 0.00 2.50 125.00 0.00 125.0004/21/14
xe1

588  Accounting SystemMHR  Preparation 40.00 46.00 -6.00 14,000.0016,100.00-2,100.0004/02/14 03/31/14
Config

588 Accounting SystemMHR Wrap Up Meeting5.00 3.50 1.50 1,750.001,225.00 525.0004/02/14 04/02/14
Config

Ace Advertising TotalsTask count = 4 51.50 49.50 2.00 16,375.0017,325.00-950.00

ALPHA Alpha Promotions
ALPHAAlpha Promotions 511 Partnership TaxRetum CATReview 2.00 0.00 2.00 500.00 0.00 500.0004/04/14

511  Partnership TaxRetum CAT Final Review 1.00 0.00 1.00 250.00 0.00 250.0004/07/14
589 Consulting -Web Design JPW Preparation 15.00 15.25 -0.25 5,250.00 5,337.50 -87.5004/17/14 03/25/14

Update
589  Consulting -Web Design JPWWrap Up Meeting000 2.75 0.25 1,050.00 962.50 04/17/14 03/31/14

Update
511  Partnership TaxRetum MHR Preparation 4.00 0.00 4.00 1,000.00 0.00 1,000.0004/02/14
511 Partnership Tax Retum  MHR Clear Review Comments1.50 0.00 1.50 375.00 0.00 375.00t1//0/t0

Printed by CATon4/15/2014 at 10:59 AM Page l
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4. In the Based on field, select Project Current Due Date from the drop-down list.   

 
5. Click the Layout tab. 

6. In the top Group by field, select Project Assigned Staff List from the first drop-
down list.  

7. In the Detail by row, Sort on column, select Project Number.   

 

Report Options

Description: Task Tracking

Description override:

SelectionLayout

Dates

Report date: Period End Date 4/30/2014

Detail line: Custom Date Rang 1/1/2014 to 4/30/2014

Based on: Project Current Due Date

Report Options
Description: Task Tracking

Description override:

SelectionLayout

Sort on: Direction: Page
Breaks:

Group by: Project Assigned S ID Ascending

(None) Ascending

(None) Ascending

Detail by: Task Project Number Ascending

Print Cover Sheet
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8. Click the Preview Selected button.   

 
9. Click the Back button on the toolbar to exit the preview. 

Restoring the sample database 
After you have completed this walkthrough, you should restore the sample database 
that you backed up (see “Backing up the sample database” on page 2). Use the 
restored sample database to complete other Practice CS walkthroughs.  

1. From the File menu, choose Restore. 

2. In the Restore dialog, enter the path to the backup file that you want to restore, 
or click the browse  button to navigate to the backup location (usually a 
subfolder of X:\Program Files (x86)\Microsoft SQL Server or X:\Program 
Files\Microsoft SQL Server, where X: is the drive on the computer where the 
data resides).  

3. In the Backup File Location dialog, click the backup file that you want to restore 
and click OK. 

Note: The backup file will have a file extension of BDF. 

4. In the Restore Firm dialog, enter a new name for the database in the New Firm 
name field.   

Parnes, Velano, Martinez & Co.

Task Tracking
January 1, 2014 - April 30, 2014

Date Based on: Project Current Due Date

p6png Target Target 
ID  Client Name Project Number Project Desqiption Assigned  Activty Hours Ready StaitComplete Tracking

CAT Turner, Cindy
ACEADVERTAce Advertsing 905  December Writeup CAT PREPARATION 4.00 01/20/14 01/30/14 Completed
PROTO Prototype Design 507 Quarterly Writeup CAT PREPARATION 4.00 01/14/14 01/24/14 Completed
CRAWFORDCrawford’s Steak House508 December Writeup CAT PREPARATION00 01/14/14 01/24/14 Completed

528 Quarterly Sales &Use Tax CAT PREPARATION2.50 01/13/14 01/20/14 Completed
529 W-2/W-3 CAT PREPARATION 6.00 01/14/14 01/20/14 Completed
530 941 Employer's Quarter Fed TRCAT PREPARATION 4.00 01/14/14 01/19/14 Completed
531 1099 CAT PREPARATION3.00 01/14/14 01/20/14 Completed

ACEADVERTAce Advertising 532 Quarterly Sales &Use TaxCAT  PREPARATION2.50 01/10/14 01/15/14 Completed
533 W-2/W-3 CAT PREPARATION 3.00 01/20/14 01/27/14 Completed

1099 CAT PREPARATION 2.75 01/20/14 01/27/14 Completed
PROTO  Prototype Design 535 Quarterly Sales &Use Tax CAT PREPARATION2.50 01/07/14 01/13/14ÿ Completed

536 W-2/W-3 CAT  PREPARATION4.00 01/14/14 01/20/14 Completed
537 1099 CAT PREPARATION 3.00 01/14/14 01/20/14 Completed
538 941 Employer's Quarter Fed TRCAT PREPARATION 4.00 01/14/14 01/19/14 Completed

BROWNI Brown, Jerald &Elizabeth 540  941 Employer's Quarter Fed TRCAT PREPARATION3.00 01/16/14 01/21/14 Completed
542 Bi-Weekly Payroll CAT  PREPARATION3.00 01/09/14 01/10/14 Completed
543 W-2/W-3 CAT PREPARATION 3.00 01/16/14 01/21/14 Completed

CRAWFORDCrawford's Steak House546 Monthly Payroll CAT PREPARATION 4.00 01/28/14 01/28/14 Completed
ACEADVERTAce Advertsing 547  Monthly Payroll CAT  PREPARATION4.00 01/28/14 01/28/14 Completed
PROTO Prototype Design 548 Monthly Payroll CAT PREPARATION 4.00 01/27/14 01/27/14  Completed
BROWNI Brown, Jerald &Elizabeth549 Bi-Weekly Payroll CAT PREPARATION 3.00 01/22/14 01/23/14 Completed
ACEADVERTAce Advertising 557 941 Employer's Quarter Fed TRMHR PREPARATION 1.00 01/21/14 01/26/14 Completed

558  February Writeup CAT  PREPARATION4.25 03/17/14 03/27/14 Completed
559 dnaum Nenuet CAT PREPARATION 4.00 02/18/14 02/28/14 Completed
560 March Writeup CAT PREPARATION4.00 Yes04/08/14  04/18/14  Not Started
561  Monthly Payroll CAT PREPARATION4.00 02/26/14 02/26/14 Completed
562 Monthly Payroll CAT PREPARATION4.00 03/27/14 03/27/14 Completed
563 Monthly Payroll CAT PREPARATION 4.00  Not Started 
564 Quarterly Sales &Use Tax CAT PREPARATION2.50 Yes04/16/14 04/21/14 NotStarted

Printed by CATon4/15/2014 at 11:21 AM Page 1
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Note: When you restore the Sample database, you must give it a different 
name. The restore process in Practice CS does not overwrite an existing 
database, and Practice CS does not allow firm databases with duplicate names. 
Therefore, you will need to give the database a different name when you 
restore it (for example, Sample1). The name may contain only alphanumeric 
characters. 

 
 

 

Restore

Please select a backup file or directory and enter a Firm name.

Backup fileldirectory:C:IProgram Files (x86)IMicrosoft SQL ServerIMSSQL10_50.CREATIVESOLUTIONIMSSQLIDATA

New Firm name:

Select the database you would like to restore:

Firm Name File Description Date
CSP_999_Sample4_20140 Manual backup created on 4/15/2014 11:26:304/15/2014

OK Cancel
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